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WARNINGS

Safety Information




WARNING!

Read Me First!

READ THIS MANUAL COMPLETELY BEFORE UNPACKING AND
POWERING UP YOUR PRINTER.

Hazards and Warnings

The TAZ 3D printer has motorized and heated parts. Always be aware of
possible hazards when the printer is operational.

Electric Shock Hazard

Never open the electronics case when the printer is powered on. Before
removing the electronics case cover always power down the printer and
completely turn off and unplug the power supply. Allow the power supply
to discharge for at least one minute.

Burn Hazard

Never touch the extruder nozzle or heater block without first turning off
the hot end and allowing it to completely cool down. The hot end can take
up to 20 minutes to completely cool. Never touch recently extruded plastic.
The plastic can stick to your skin and cause burns. The heated bed can
reach high temperatures that are capable of causing burns.

Fire Hazard

Never place flammable materials or liquids on or near the printer when
it is powered on or operational. Liquid acetone and vapors are extremely
flammable.

Pinch Hazard

When the printer is operational take care to never put your fingers in
any moving parts including belts, pulleys, or gears. Tie back long hair or
clothing that can get caught in the moving parts of the printer.



HAZARDS AND WARNINGS

Static Charge

Make sure to ground yourself before touching the printer, especially its
electronics. Electrostatic discharge can damage electronic components.
Ground yourself by touching a grounded source like your computer case.

Age Warning

For users under the age of 18, adult supervision is recommended. Beware
of choking hazards around small children.

Federal Communications Commission Statement

This device complies with part 15 class A of the FCC Rules. Operation is
subject to the following two conditions:

1. This device may not cause harmful interference and

2. This device must accept any interference received, including interfer-
ence that may cause undesired operation.

FCC Warning: Changes or modifications not approved by the party
responsible for compliance could void the users authority to operate the
equipment.

xi
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3D Printer Software

1.1 Software Overview

Aleph Objects, Inc., the maker of the LulzBot™ TAZ, completely supports
free/libre hardware and software. Along with the TAZ being a free/libre
hardware design, it has been tested to work with 100% free/libre software.
Our source code and design files are hosted on our development server found
at http://devel.lulzbot.com. To operate your desktop 3D printer you
will need to install a few software packages onto your PC. You will need
a 3D printer host, an .STL to .gcode generator, and optional CAD or 3D
modeling software.

1.2 Software Types

Printer Hosts
Printer Host software is used to control the 3D printer. The program
not only allows you to manually move the printer along all the axes,
but set temperatures manually, send commands and receive feed-
back/error messages from the onboard electronics. We recommend
that new users start with Cura as it includes a slicing engine as well.

Common Printer Hosts:

o Cura

 Printrun (Pronterface)
o MatterControl

e OctoPrint

« Botqueue

Slicers
These programs take the 3-Dimensional model (typically
STL/OBJ/etc) and determine the 3D printer toolpath based
on the options selected. The slicing engine uses the nozzle diameter,
printing and movement speeds, layer height and other variables to
determine the coordinates where it needs to move and the rates
at which it will do so. This information is exported out of the
program as a gcode file. The gcode file is a plain-text file with a
series of text-based codes and a list of the complete X,Y and Z axis

14



1.3. INSTALLING DRIVERS

coordinates used for printing the 3D model. We recommend that
new users start with Cura as it includes the printer host as well.

Recommended Slicers:

e Cura

e Slic3r

All of the following free/libre software packages are available for
GNU/Linux, Windows, and Apple OS X. However, we highly recommend
using these programs on GNU /Linux.

The required software can be found in the Support/Downloads section
at LulzBot . com/support/downloads. You will also find instructions there
for installing each program onto your PC. You can also find downloads
specific to the LulzBot™ TAZ 3D printer on the LulzBot™ TAZ product

page.

1.3 Installing Drivers

Linux and Mac OSX users will not need to install a driver to commu-
nicate with the TAZ 3D printer. Windows users will need to install
the drivers. Using Cura as your printer host and slicing software is
recommended, as the drivers will automatically be installed during the
Cura installation process. The drivers can also be downloaded from
LulzBot.com/support/downloads. A visual guide showing the driver
installation process can be found in our download section as well.

1.4 Cura

Setup Cura

Cura is available for download on our website at lulzbot.com/cura. When
installing, it is recommended to uninstall any previous versions of Cura you
may have been using. When first opening Cura, you will be prompted to go
through the First run wizard. This will consist of selecting your printer
and then your nozzle size.

15



3D Printer Software

It is important to select the correct printer and nozzle size, as Cura uses
custom profiles and machine settings based upon which printer and nozzle
you are running.

o Download the appropriate installer for your computer operating
system. Instructions on installation for each operating system is
available at http://LulzBot.com/cura.

 Install Cura by double clicking on the installer.
e Select LulzBot TAZ.
e Once the proper printer is selected, select Next.

o Choose the appropriate nozzle size for your TAZ, select Next.

Once the installation wizard finishes you can move forward with your
first print!

1.5 Quick Print Settings

L‘ﬂ D
)i |_noawaL |

23 llAES
Q.91 mEHEP 7 EFEm

Figure 1.1: Quick Print Settings
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1.5. QUICK PRINT SETTINGS

After setting up Cura for the first time, you will be shown the main interface
screen. (Fig. 1.1, page 16):

Selecting a Quick Print Profile

The print quality settings can be found in the top left-hand corner of the
window. For most filaments, there will be High Quality, Normal Quality,
or Fast Quality options. Some of the more exotic filaments may only have
a Normal Quality profile.

High Quality
Designed to give greater detail and finer objects. This will have a
smaller layer height, which will make each layer thinner, so that curves
seem more natural and walls seem less noticable. This setting will
also require more layers to be laid down, increasing overall print time.

Medium Quality
Designed to give a medium resolution, by increasing the layer height
and print speeds. This will make the organic curves slightly more
step-like than the fine setting, but will reduce printing time.

Fast Quality
Designed for the fast prints, where overall model finish is not of
concern. Most commonly used for quick iteration of designs found
in rapid prototyping.

Material Selection

Choose your desired filament. The TAZ ships with a 1 meter sample of
ABS, that should be used in your first print.

Printing Support Material

The TAZ 3D printer is able to print models that have angles and overhangs,
even without support material depending on the overhang distance and
angle. Turn this option on if your model could benefit from support
material.

17



3D Printer Software

Brim

Brim is used to increase surface area of the part you're printing, thereby
ensuring proper part adhesion. This will print a single layer high edge
around the outside of the part, helping first layer adhesion and minimizing
warping.

Load Model File

Select the STL model you would like to print. Either use the Load Model
button or select File > Load Model. Once the file has been loaded, you
will see a 3D rendering of your object on the build platform. Select the
model to see the various options.

Model Orientation

Move your model to change where it is printed on the build plate. Do this
by left clicking on the model and dragging it to the desired location. The
black outlined corner of the 3d print bed view represents the front left
hand corner of the build plate on your printer. By holding down the right
mouse button and dragging, you can view your model from different angles.

28 IES
0.9 meiEr 7 grm

— . ‘
s\ g™

2N

Figure 1.2: Options after selecting model
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1.5. QUICK PRINT SETTINGS

Rotate

The Rotate button will give you the ability to orient your model in along
all three axes. Once you click the rotate button, three circles will surround
your model. The red circle will allow you to rotate around the 7Z axis. The

will rotate around the . The will rotate
around the . Cura defaults to 15 degree incriments. Hold Shift to
rotate by One Degree Incriments.

2 2 QD
miAuEs

23
Q.91 msier 7 gt

Figure 1.3: Rotating your Model

Lay Flat

The Lay Flat button will ensure that the flat portion of your print is
securely attached to the bed. It is highly recommended to use this option
after rotating your model in the Z direction, as it will help prevent adhesion
issues during the print.

Reset

The Reset button will return your model to the original orientation as
defined by the CAD program used to create the model.

19



3D Printer Software

Scale

The Scale button displays the model dimensions, along with the ability to
scale along the X Y or Z axes. Anything below the number 1.0 will reduce
the objects size, while anything above the number 1.0 will increase the
objects size. As a default, it will be set to uniform scaling. This will cause
the X Y and Z axes to be scaled by the same amount when you make a
change to any of them. To disable this, select the lock in the lower section
of the scaling window.

W, D, H: 73.3, 74.0, 23.5 mm
ﬁ:—ﬁ)
o ‘ @
0.5
e 0.5
R 73.28
) 73.98
23.47
& J & J o;J

Figure 1.4: Scaling your Model

1.6 View Options

This mode allows you to view your model in a variety of different ways.
This can be helpful for spotting issues before the print even starts.

Normal

This is the standard view and shows the solid outer surfaces of the model.
(Fig. 1.5, page 21):
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1.6. VIEW OPTIONS

5 afmes
@68 mEery g ;
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-

Figure 1.5: View in Normal Mode

Overhang

Overhang mode shows where your model may need support material. In
Fig. 1.6, page 21 the red highlighted areas show overhangs and more severe
angles and areas where support material is recommended. The overhang
threshold can be defined in Expert Settings.

»
®

| snus cooe
T &7 ifincias
.90 P & g

Figure 1.6: View in Overhang
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3D Printer Software
Ghost

Ghost view mode makes the model translucent to allow you to see what is
behind it.

Fle. Toos Machine Exper Help
Basic | Advanced Pigins| StartEnd-GCose.

Figure 1.7: View in Ghost
Xray

Xray is very similiar to Ghost mode. It will alow you to see into objects,
ensuring that inner details are correct.

Figure 1.8: View in Xray
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1.6. VIEW OPTIONS

Layers

To view the toolpath of your print head and to ensure no skipped layers
or gaps use this option. Use the slide bar on the right hand side of the
window to move up and down through the toolpath layers. Click the icon
below it to view an individual layer at a time. If there is support activated
in your model, it will be shown in blue.

Figure 1.9: View in Layers

Figure 1.10: Viewing Cumulative Layers
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3D Printer Software

Figure 1.11: Viewing Specific Layers

1.7 Starting Your First Print

Once you have your model, profile, and filament loaded, it is time for your
first print!

The TAZ has the ability to print directly from their computer using the
USB cable, or if they would like to print from their SD card.

Printing from SD Card

Save your Gceode file to your SD card. Select File > Save Gcode and
choose the SD card location. Insert the SD Card into the Graphical LCD
Controller.

Set Temperature

Turn on the heated bed and hot end by using the Graphical LCD controller
and navigating to: Temperature > Select Filament type. If you are
using other materials you can set your desired temperatures by going to
Temperature > Custome Temp > Nozzle/Bed. Wait for your 3D printer
to reach specified temperatures.

24



1.7. STARTING YOUR FIRST PRINT

Start Print

Once at the desired printing temperature begin your print through your
Graphical LCD controller by navigating to: Print From SD > Desired
File.

Printing from USB Cable

Connect your 3D printer to a computer using a USB cable, power it on
and select the Control button at the top of the 3d viewing window. This
will bring up your Pronterface user interface. You will not be able to send
any commands until the window title changes to Operational. Once it
is operational, you will need to set your filament specific temperatures.
The temperature box heats the hot end, while the bed temp sets the bed
temperature. Your current temperatures will be listed in the top of the
control box. Once your hot end and bed are heated, select Print. This
will start the printing process.

Ope 0 : = = Bed

Cancel Motors Off

< = echo:Marlinl.e.@

< echo: Last Updated: Nov 17 2014 09:15:31 | A
= Compiled: Nov 17 2014

< echo: Free Memory: 4882 PlannerBufferBytes:
< echo:Hardcoded Default Settings Loaded
< echo:5teps per unit:

< gcho: M92 X100.50 Y100.50 Z1600.80 EB33.00
< gcho:Maximum feedrates (mm/s):

< echo: M203 XB00.00 YBOO.Q00 Z8.00 E40.00
= gcho:Maximum Acceleration (mm/s2):
<<
<
<
=
<
<
<<
<
<

echo: M201 X9000 YO0O0O0 Z1068 E1000
echo:Acceleration: S=acceleration, T=retract
echo: M204 S2000.00 TI0E0.00

echo:Advanced variables: S=Min feedrate (mm/
echo: M205 S0.00 T0.00 B20000 X12.08 Z0.408
echo:Home offset (mm):

echo: M206 X0.00 Y0.00 Z0.00

echo:PID settings:

oowWHN EXTRUDE

W] echo: M301 P2B.79 I11.91 D1@E.51
0 TEMPERATURE
200 0 °C
200 o]
égﬁ BED TEMP 7l T =
0 —lo

Figure 1.12: Control Screen
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3D Printer Software

Pausing Midprint

You will notice after starting your print, the print button has changed to
a pause button. This will pause your print after it has run through its
Gceode buffer. Cura will remember the location of your printheads X and Y
coordinates if moved through Cura This allows you to move the printhead
away from your print and change filaments, colors, etc. When you hit
resume, Cura will bring the printhead back to the original (X,Y) before
resuming. Disabling the motors, and manually moving the printhead will
cause Cura to lose the (X,Y) positioning. Cura will NOT remember any
Z movements. If you would like to move in the Z direction, be sure to make
the opposite movement before resuming.

Recommended Temperatures

When preparing your printer for operation, please be sure to set your
temperatures to the specific filament you are using.

H Filament Type Bed Preparation Nozzle Temp Bed Temp Removal Temp H

ABS Clean PEI 240-260 110 50

PLA Clean PEI 195-215 60 45

HIPS Clean PEI 240-260 110 50
Laywood Clean PEI 175-195 60 45
Laybrick Clean PEI 175-195 60 45
T-Glase Gluestick 240-260 60 45
Flexible Filaments GlueStick 215-230 50 35
Nylons Gluestick 220-270 110 50
PolyCarbonate Gluestick 260-300 110 50
N-Vent Gluestick 220-260 110 50

1.8 Removing Your First Print

After your first print has finished, you need to wait for the part to cool
down. Your parts will be easier to remove if you allow your heated bed to
cool down to optimal temperature. This will allow the plastic to contract,
making it easier to remove.

26



1.9. FULL SETTINGS

Once your heated bed has cooled, use the blue handled knife that was
included with your toolkit to remove the item. Carefully insert the blade
of the knife between your print and heated bed. Once underneath the part
rotate the blade- lifting with the sharp edge into the part, to gently pop
the piece off your plate.

1.9 Full Settings

Full settings should not be used until enough experience with 3D printing
has been gained to feel comfortable with all aspects of the printer and its
operation. The simple settings will provide good results for most models.
The first time Cura is launched it will default to the Quick Print interface.
In order to have more control of your slicing and Gcode generation, switch
to Full Settings. Select Expert > Switch to full settings. If a
quickprint profile for your filament type is available, be sure to have it
selected. This will automatically update the settings for that filament.
The following tabs will now be available: Basic, Advanced, Plugins, and
Start /End-Geode. You will also have access to the Expert Settings.

Figure 1.13: Differences in Layer Height
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3D Printer Software

View in Full Settings

When you first switch to Full Settings, Cura will need to know what filament
and quality you wish to use. It will automatically transfer our quickprint
settings over to allow adjustments if one is selected. IF A QUICKPRINT
PROFILE IS NOT AVAILABLE, YOU WILL NEED TO MANUALLY
LOAD ONE IN. We recommend using our tested profiles that are available
here: https://www.lulzbot.com/support/downloads. You will want to
choose the profile that matches your filament and quality needs. Once
downloaded, you can load the file into Cura by selecting File > Open
Profile. Choose your desired profile. This will automatically update all
of your settings for use with your printer.

1.10 Basic Tab Options

Layer Height

The thickness of each printed layer is known as the Layer Height. The
smaller the layer height, the smoother curves will appear. Larger layer
heights are better for bridging and overhangs. Smaller layer heights will
also increase print time, as it will take more layers to complete the object.
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1.10. BASIC TAB OPTIONS

Figure 1.14: Differences in Layer Height

Shell Thickness

This defines the number of vertical walls that comprise the outside of your
model. We recommend keeping this set to multiples of your nozzle width.
Your TAZ 3D printer is equipped with a 0.35mm nozzle or a 0.5mm nozzle.

Enable Retraction

Retraction tells your printer to pull filament out of the hot end upon travel
moves. Travel moves are when your print head moves from one area of the
print, to another without laying down filament. We recommend keeping
this on for all filament types, and adjusting the retraction length and speed
for the specific filament.

Bottom/Top Thickness (mm)

Also known as Surface Layers- this will determine how thick the top
and bottom layers are. A larger number here will create a thicker top and
bottom which can be helpful for strength, bridging, and quality purposes.
We recommend keeping this number as a multiple of your layer height.
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3D Printer Software

Fill Density

This number is expressed as a percentage. 0% will give a completely hollow
print, while 100% will give you a completely solid object. We have found
that 20% to 40% fill density is functional for most prints.

Perimeters Before Infill

This option will toggle in what order the infill and perimeters are printed.
We recommend leaving this toggled.

Print Speed (mm/s)

Your overall printing speed can be adjusted here. If no other speeds are
determined in the later sections your printer will automatically default to
this speed. This speed will be different, depending on what type of filament
you are using.

Printing Temperature

We recommend leaving this temperature setting to “0”. If you set your
temperature in this section your printer will not begin printing until it
reaches the EXACT temperature. We recommend setting your printing
temperatures through the Pronterface UI, or through your LCD.

Bed Temperature

We recommend leaving this temperature setting to “0”. If you set your
temperature in this section your printer will not begin printing until
it reaches the EXACT temperature. We recommend setting your bed
temperatures through the Pronterface UI, or through your LCD.

Support Type

Some models will require support material in order to print properly. This
will usually occur when an object has an angle in relation to the build plate
between 0 to 45 degrees. It is highly recommended to orient your object so
that it minimizes or eliminates the need for support.
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1.10. BASIC TAB OPTIONS

Touching Buildplate

This causes the support material to build up between the heated bed and
the object. The red example is Touching Buildplate.

Everywhere

This prints support material between the heated bed and object as well as
between the object and itself. The green example is Support Everywhere.

Figure 1.15: Support Types

Platform Adhesion Type

Some models have a small surface area contacting the plate. This can
create adhesion issues causing your part to pop off at some point during
the print. To fix this, use either Brim or Raft. Raft is better used when a
model has small heated bed contact points and overhangs.

Brim

Brim will create a single layer of filament, contacting and surrounding your
model. This will increase the surface area of the part contacting the build
platform thereby preventing it from popping off the heated bed. Brim will
also help in situations where you are seeing corner lift. Brim settings can
be adjusted in the Expert Settings options.
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3D Printer Software

Raft

Raft will generate a layer of material underneath your object. Raft was
more often used before the addition of heated plates to increase surface
area. Raft settings can be adjusted in the Expert Settings options.

Filament Diameter

The filament diameter setting is one of the more important settings. Make
sure that you update this value periodically with your average filament
diameter. While your filament may be referred to as 3mm, it is more
likely going to be near 2.9mm +/- 0.lmm. You will want this to be an
accurate average, as it will allow your printer to correctly calculate how
much filament it is pulling into the hot end.

Filament Flow %

This controls how much filament your printer is extruding in relation to
speed. This setting is mainly used to adjust for filament density variations.
Leave this value at 100% as changing it can lead to surface quality issues.

1.11  Advanced Tab Options

Nozzle Size (mm)

This defines your nozzle size. The slicing engine uses this value combined
with your other settings to determine how quickly to feed filament into your
hot end. The TAZ ships with a 0.35mm or a 0.5mm nozzle.

Retraction Speed (mm/s)

Retraction Speed determines the speed at which your filament is reversed
out of the hot end for travel moves and when changing direction during
printing. We recommend keeping this set to 25mm/s.
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Retraction Distance

Retraction Distance determines how much filament is pulled out of your hot
end on travel moves and when changing direction. You will want to adjust
this depending on temperature settings and filament type. Higher thermal
retaining filaments such as PLA behave better with a longer retraction
distance. We have found anywhere from 1lmm to 3mm is a good starting
range.

Initial Layer Thickness

This will control how thick your first printed layer height is printed onto the
heated bed. Having a larger initial layer height will help prevent your part
from popping off the plate. All of our standard profiles have a 0.3mm initial
layer height. This eliminates the need for adjustments when switching
between filaments.

Initial Layer Line Width

This will control how wide your first extruded filament path is for the initial
layer. A wider line width will help with bed adhesion. We have found 125%
to be a good starting place. For models with moving printed in place parts,
a smaller initial layer line width is recommended.

Cut Off Object Bottom (mm)

This setting is used to help print models that were not specifically designed
for FFF printing. In particular, it is for models that do not have a flat
surface to adhere to the plate. It will sink your object Xmm into the build
plate, creating a nice flat surface to begin your print. You can also use this
option to remove the lower portion of your model, or if carefully measured,
cut your part in half for printing object as two halves.
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- Cura - 14.09 4 -0 X
file Tools Machine Expert Help

Basic Advanced Plugins Start/End-GCode

Machine " ¥ -
Nozzle size (mm) 05 j 2 QD

Retraction 2 90 EifEs
Speed (mm/s) 20 418 meier $8 grm

@
S

Distance (mm) 3
Quality

Initial layer thickness (mm)

Initial layer line width (%) | 125
Cut off object bottom (mm) | 20
Dual extrusion overlap (mm) 0.15
Speed

Travel speed (mm/s) 150

Bottom layer speed (mm/s) |25

Infill speed (mm/s) 55

Outer shell speed (mm/s) |45

Inner shell speed {mm/s) |50

Cool

Minimal layer time (sec) | 20

Enable cooling fan v -

' | < | @O

Figure 1.16: Cutoff Example

Dual Extrusion Overlap

This will determine how far your Dual Extruders will overlap when laying
down material. This will help adhesion between the two different colors or
types of filament. This setting is only used when the printer is equipped
with two hot ends and extruders.

Travel Speed

This setting will determine how fast your print head moves while not ex-
truding filament. A normal travel speed of 125 - 175mm/s is recommended.

Bottom Layer Speed

This will control your initial layer speed. In general, a slower initial layer
speed will help with first layer adhesion.
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Infill Speed

This is how fast your print head speed will be while laying down the interior
portion of your model. Faster speeds are usually tolerable here, as none of
the infill will be visible from the outside of your object. If you go too fast
compared to your inner and outer shells, you can have adhesion issues or
globs of filament left behind from the printhead.

Outer Shell Speed

This will be the outermost surface of the model. This is the most important
speed setting, as it controls the speed of your print head on the visible layers.
As a general rule of thumb, the slower you go the better looking print you
will get.

Inner Shell Speed

This affects vertical walls that are in between the outer shell and infill. This
will not be visible but will help support the outer shell and the infill. We
recommend keeping this speed setting between your infill and your outer
shell speed.

Minimal Layer Time

This will determine a minimum amount of time your printer will spend
laying down each layer. If your layer print time falls below this your printer
will automatically slow down to reach this time before moving onto the next
layer. Tweaking this can help get cleaner, crisper prints.

Enable Cooling Fan

Enables operation of your extruder’s active cooling fan. The fan settings
can be adjusted in the Expert Settings options.

1.12  Plugins

Plugins are custom settings which will alter your print at specific
points. The two that come pre-loaded with Cura are Tweak at Z, and

35



3D Printer Software

Pause at Height. More plugins and information can be found here:
http://wiki.ultimaker.com/Category:CuraPlugin To activate one of
these highlight the desired plugin and click the drop-down arrow directly
below the Plugins box.

A o)
QD |40 3CD
oo moeL | )
6]
6.60 metiar 7 g

Figure 1.17: View of Plugins

Tweak at Z

Make basic changes at specified Z heights. You can determine the Z height
or layer count at which you want to make a change. Then choose how you
would like to change your settings. You can alter temperatures, fan speeds,
and print speeds. Fine tuning these for specific STL files, can produce
cleaner prints.

Pause at Z Height

Pause your print at a specified height. You can also specify where to
move the print head and how much filament to retract. This will prevent
“blobs” from accumulating on your print while paused. This setting is most
commonly used when switching colors of filaments in the middle of a print.
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1.13 Start and End Gcode Settings

Custom Gcode allows for complex automatic printer movements and
operations. By adding custom Gcode into the start or end of your
file, you can alter how it prints. A comprehensive list of Gcode
commands can be found here: http://reprap.org/wiki/G-code We
recommend new users to leave this as provided in the profiles at
https://www.lulzbot.com/support/downloads

1.14 Expert Settings

Expert settings will give you more specific options for your retraction, skirt,
active cooling, infill, support, brim, raft, and special settings. To gain
access to this section you go to Expert > Open Full Settings or on your
keyboard press Control + E.

- Expert config X
Retraction Support
Minimum travel (mm) 15 Structure type Lines ~
Enable combing v Overhang angle for support (deg) | 45
Minimal extrusion before retracting (mm) 0.02 Rl amount (%) 3
Z hop when retracting (mm) 0.1 DistancelXmmm) 07
Skirt Distance Z (mm) 0.05
Line count 1 Black Magic
Start distance (mm) 3.0 Spiralize the outer contour
Minimal length (mm) 250 Only follow mesh surface
cool Brim
Fan full on at height (mm) 2 Brim line amount 10
Fan speed min (%) 60 Raft
Fan speed max (%) 80 Extra margin (mm) 5.0
Minimum speed (mmjs) 10 Line spacing (mm) 3.0
Cool head lift Base thickness (mm) 0.3
Infill Base line width (mm) 10
Solid infill top G Interface thickness (mm) 0.27
Solid infill bottom v

Interface line width (mm) 0.4
Infill overlap (%) 15

Airgap 0.5

Surface layers 2

Fix horrible

Combine everything (Type-A) v

Combine everything (Type-B)

Keep open faces

Extensive stitching

Ok

Figure 1.18: View Expert Settings
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1.15 Retraction

Retraction pulls filament out of your nozzle when it is not extruding to
prevent your print head from dripping on your object. This section is
where you will control how your extruder retracts its filament.

Minimum Travel

This sets the minimum travel distance of your printhead in order to retract.
If your print head is not moving this far during travel moves, it will not
retract.

Combing

This option prevents your print head from traveling over holes in the
X/Y plane when printing. This will slightly increase print time, but will
prevent strings from getting caught on the holes during travel moves. We
recommend keeping this setting on.

Minimal Extrusion Before Retracting

This will prevent a retraction move, if your extruder has not put out Xmm
of filament since its last retraction.

Z Hop When Retracting

This will raise your print head Xmm while retracting. This setting helps
prevent ooze, and strings from being deposited on your print.

1.16  Skirt

Skirt creates a line around the outside of your object. Most commonly used
to prime the extruder, in order to prevent missed filament at the beginning
of a print. Leave this setting on.
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Line Count

This will define the number of loops the Skirt creates around the outside
of your object. Smaller models will require more loops to properly prime
the extruder.

Start Distance

This will define the distance away from your model that the skirt will be
created.

Minimal Length

This will define the minimum extruded line length for the skirt. This will
over ride your line count, producing as many lines as required to reach the
minimal length.

1.17 Cool

This section will define how your extruder cooling fan will operate during
the print. Your fan will not start until it has reached 25% or higher for
speed settings. If your print speeds are slowed down due to minimal layer
time, the fan will run between minimum and maximum speed based upon
how much the layer is slowed down.

Fan on at Full Height

This is your Z height where your fan will be turned on to its minimum
percentage setting. Especially helpful with high temperature retaining
filaments such as PLA. This will be scaled between 0%, and your minimum
fan speed based upon layer height; with it being disabled for the first layer.

Fan Speed Min

This will be the speed your fan runs when enabled at full height. Once the
Z height is reached for Fan on at Full Height, this will be the speed your
fan runs at.

39



3D Printer Software

Fan Speed Max

This is the fastest speed at which your fan will ever run. When your print
speed is slowed down due to minimal layer time, your fan will run between
minimum and maximum speed. The maximum fan speed is reached when
your printer must be slowed by 50% or greater.

1.18 Support

You define how your support material is generated here. You must have
some form of support turned on in the basic settings in order for these
settings to have an effect.

Structure Type

You can choose between a Grid or a Line pattern for your support material.
The grid will be a checkerboard pattern in the X and Y direction. The
line option will produce lines in along the y axis for support. The grid
will provide stronger support than the line option, but will be harder to
remove.

Overhang Angle for Support

This will determine where support material is generated. In general you
will be able to print a model with 45 to 90 degree angles in relation to the
bed without support. We recommend leaving this setting at 45.

Fill Amount

This will determine how dense your support material is printed, similar to
Infill Percentage. The higher percentage the better support, but it will be
harder to remove the support material and will use more material.

Distance X/Y

This will determine how far away from your object in the X/Y plane that
the support material is being placed.
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Distance Z

This will determine how far away your support material is from your object
in the vertical direction. A smaller number here makes for better support,
but makes it harder to remove.

1.19 Black Magic

This section allows you to transform your model into a hollow shell, a single
layer thick.

Spiralize the Outer Contour

This causes your Z axis to be constantly moving upward as printing your
single outer wall shell. The results are no layer change lines, giving a much
smoother surface. This setting is typically only used for artistic objects as
they will be fragile.

Only Follow Mesh Surface

This will cause your print to follow the outside of your model, building
it completely hollow with a single wall outer shell. The only difference
between this and Spiralize, is that the Z axis moves regularly. That is, it
prints a layer and then moves up to the next one.

1.20 Brim

Brim circles the base of the print while making contact, helping adhere
the print to the heated plate. This is only one layer thick, and easily
removed post-print. This section defines how the brim is formed when
brim is activated in basic settings.

Brim Line Amount

This will determine the distance the brim will cover around the outside of
your object. The more brim used, the better your part will adhere to the
plate.
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1.21 Raft

Raft is a platform built underneath your object, designed to help adhesion
and prevent warping. It will lay down support material, and then a
platform on top of the supports. Your model will be built on top of this
platform. The bottom surface of your printed part will not be as clean or
as even when using this option. Raft is typically not required.

Extra Margin

This determines the distance around the outside of your object that the
raft is created. Can be helpful for ensuring no warping of the lower layers.

Line Spacing

This will determine the spacing between “support” lines for the raft. A
small spacing makes the support structures closer together improving
strength of the raft, but uses more material.

Base Thickness
This defines how thick your raft will be.

Base Line Width

This will define how wide your “support” material is for the raft. This
setting will determine how well the surface layers of the raft print.

Interface Thickness

This will determine how thick the surface layers of the raft are. The surface
layers are the platform that is built upon the supports.

Interface Line Width

This will determine how wide the top layers of the platform will be. In
general, you can keep this set to your nozzle size, as surface quality of the
removable raft is not important.
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Airgap

This will define the distance between your raft and your print. A larger
gap will make your part easier to remove, but will make the bottom of your
print look worse.

Surface Layers

This will determine the number of layers that create the “platform” of your
raft. If you have a wide line spacing, you may want to increase this number
to ensure a solid platform.

1.22 Fix Horrible

These are some of the more advanced and experimental options. They are
designed to help repair models with errors to make them suitable for 3D
printing. They do not always work. Please be cautious when using these
options as they can have unintended effects on your print quality.

Combine Everything (Type-A)

This will attempt to fix all external mesh errors, while keeping internal
holes intact. This can accidentaly fill in intentional internal holes.

Combine Everything (Type-B)

This will ignore all internal holes of the model and only focus on the external
holes. This is helpful when only the outside finish of the model is important.

Keep Open Faces

This will ignore all manifold errors in the object. It can create issues
generating the Gceode as Cura does not know how to interpret the open
holes. This option should only be used if you are sure that the holes in the
mesh are intended. In general, you should not use this option.
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Extensive Stiching

This causes Cura to automatically add triangle meshes in an attempt to
fix manifold errors. This algorithm will greatly increase Gcode generation
time and may end up adding in un-intended meshes. It is recommended
that you repair your model through Meshlab, FreeCAS or your preferred
CAD program before attempting this option.

1.23 Dual Extrusion

The LulzBot TAZ has the ability to add dual extrusion functionality with
the Dual Extruder tool head add-on. We only recommend the Dual
Extruder tool head for advanced users. Installation and operation of
the dual extruder will require you to flash your firmware, calibrate your
extruders, level two heads to a single plane, define extruder offsets, and fine
tune your slicing profile. This can be a little overwhelming for new users,
and is recommended to get a couple months of single extruder printining
experience before making the switch.

Updating Firmware

In order to use the Dual Extruder you will need to update your firmware
to activate the second hot end.

e Download the printer appropriate firmware from

https://www.lulzbot.com/support/firmware-flashing-through-cura

Be sure it is saved as a .hex file.

o Have the printer turned on and connected to your computer through
USB.

e Open Cura and select Machine > Install Custom Firmware
o Select the appropriate hex file
e Once the progress bar has completed, you will be done!

e You can verify this by looking at the LCD screen. You should now
see three temperature readings.
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Preparing Cura

In order to slice for a second toolhead, you will need to let Cura know that
you have added a second toolhead. To do this, please go to Machine >
Machine Settings > Extruder Count > 2. Select Ok to close out the
screen. Next you will need to open the Machine settings again. You will
now notice a new section labeled Extruder 2. Within it you will see an X
offset and Y offset. Please set the X offset to 0 and the Y offset
to -50.

Calibrating Extruders

Each individual extruder will have its own unique set of Esteps. To
determine this, you will need to tell the extruder to take in 100mm of
filament.

e« Load the outer and inner calibrations squares into Cura
https://www.lulzbot.com/support/downloads

e Open the Control window and set temperatures for both heads.
Switch between hotends by entering TO (rear) and T1 (front)
into the command line.

e Make two marks at 100mm and 120mm on the filament from each
entrance to the extruder.

e Once at temperature type into the command line "G92” enter. Then
”"G1 E100 F60” enter.

» Switch to the other toolhead by entering "T0O” for the rear or "T1” for
the front.

e Type into the command line "G92” enter. Then "G1 E100 F60” enter.

e Measure the distance that the toolhead over/under extruded. You
will need to adjust your Esteps by 8 up or down for each mm it under
or over extruded.

« Update your Esteps (rear) and Elsteps (front) through your LCD
screen. Configuration > Advanced Settings > E/El Steps >
New Number (click)
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o Store your new E steps Configuration > Store Memory

Defining Second Extruder Offset

To get crisper looking prints, you will want to really dial in your offsets.
With the outer and inner square on your build platform, right click and
select Dual Extrusion Merge The red square will be printed with your
front extruder, and the yellow square will be printed with the rear extruder.

After printing the squares, you will want to measure Top, Bottom, Left,
and Right gap. Enter these numbers into our offset calculator found here:
https://www.lulzbot.com/dual-extruder-calibration-calculator
This will produce new offsets, that will need to be updated in the Machine
Settings menu. Repeat as many times as desired to truely fine tune the
offset.

First Dual Print

When you are ready to produce your first dual extrusion print, you will
need to combine the two separate STL files. One STL file will be for each
printhead. Left Click on whichever STL you would like printed with the
Rear Toolhead. Then Right Click on whichever STL file you would like
printed with the Front Toolhead and select dual extrusion merge. You will
now see a single model in two colors on the buildplate. The red section will
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be printed with the fron extruder, while the green section will be printed
with the rear extruder.

L Cura - 15.02.1 4+ - 0X
File Tools Machine Expert Help

Basic | Advanced | Plugins | Start/End-GCode a

A ]

- i @

Quality ch i
Layer height (mm) .25 [
AzuElzeminites)
Shell thickness (mm) 1.0 ﬂ’ﬁ]@m
Enable retraction v . 878 Meter $0

Fill
Bottom/Top thickness (mmj)| .84

Fill Density (%) 20
Speed and Temperature
Print speed (mm/s) 50
Printing temperature (C) 0

2nd nozzle temperature (C) | 0

Bed temperature (C) 0
Support
Support type None > .
Platform adhesion type Brim -
Support dual extrusion Both -
k
Dual extrusion
Wipe&prime tower v
Ooze shield Cd
Filament
Diameter (mm) 2.85

Figure 1.19: After Merge

Setting Dual Temps

After your object has been merged as intended, you will need to set the
individual temperatures for each print head. Open the Control Box as
normal a normal print. In order to switch between which hot end you are
heating, you will need to manually enter TO to set temps for the rear hot
end, and T1 to set temps for the front hotend. The Bed temp can be set
from either TO or T1. Once both print heads and the bed has reached
temperature, go ahead and hit Print.
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Fle Tools Machine Expert Help
Basic Advanced | Plugins | Start/End-GCode
Quality 2
Layer height (mm) 2 -

Shell thickness (mm) 1.0 4 hours 17 minies
Enable retraction v 618 meter 43 grm

Fin
Bottom/Top thickness (mm) .84
Fill Density (%) 20
Speed and Temperature

print speed (mm/s) 50

Diameter (mm) 285

Diameter2 (mm) 285
Flow (%) 100.0

Figure 1.20: Before Merge

1.24 Printrun

Website: http://www.github.com/kliment/Printrun The host software,
Printrun, can be used to start up and control your 3D printer (Figure 1.22,
page 51). The host controls include: setting the extruder and print surface
temperatures, manual control of each axis, and manual extrusion. The host
is also where you can push print files (.gcode) to the 3D printer or load
print files from the SD card for printing out model designs.

Installing Printrun

Printrun contains several different applications that can be used to con-
trol the TAZ 3D printer. It can be installed on Windows, Mac OSX
and Linux based computers. Pronterface is the graphical user interface
for Printrun. Pronsole allows printing from the command line, and
can be used for scripting and some automation. Plater allows you
to arrange and combine several STL files into one. More information
on the other programs within the Printrun package can be found at
https://github.com/kliment/Printrun. Printrun can be downloaded
from LulzBot.com/downloads. Download the version for your operating
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Printer Interface

File Settings
Port JdevjttyAC| ¥ @ 115200 ¥ |Disconne| Reset | Load file| Compose | SD Print Pause Recover
Motors off X¥: 3000 |, mm/min Z: 200 : Connecting...

start

Printer is now online.

echo: External Reset

Marlin 1.0.0

echo: Last Updated: 2012-05-02 | Author: erik
Compiled: Nov 21 2012

echo: Free Memory: 4717 PlannerBufferBytes: 1232
echo:Using Default settings:

echo:5D card ok

Heat: Off | 200.0 | * | Set |Check temp

Bed: Off |60 (pl| * | Set 200
Extrude _‘ mm 150 Graph offline
o mm/ o0

Reverse :

+ Send

3

Figure 1.21: Printrun application for 3D printer control

system and extract. You will need an archive manager to extract the files.
If you do not have one installed we recommend using 7-zip, which can be
downloaded for free at www.7-zip.org.

Windows Instructions

e Once downloaded, extract the dist folder to a location of your
choice. You can rename the dist folder if you like. Double click
pronterface.exe to run Pronterface.

Mac OSX Instructions

« Once downloaded, extract the dist folder to a location of your choice.
Once extracted, double click the pronterface-mac.app file to install.
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Linux Instructions
Debian|Ubuntu

Recommended Installation

e We recommend using the stand-alone Printrun option found at
https://www.LulzBot.com/downloads. Once downloaded and ex-
tracted, navigate to the extracted directory. Install the dependencies
by issuing the following command in a terminal: sudo apt-get
install python-serial python-wxgtk2.8 python-pyglet. Once
the dependencies have been installed, run Pronterface by using the
following command in a terminal: python pronterface.py.

Installing from source

o Using Git, in a terminal issue the following command: git clone
https://github.com/kliment/printrun.git

e Once downloaded, change to the Printrun directory. You will need to
ensure that the following dependencies are met. They are listed in the
README.md file. You can use this command to install the depen-
dencies: sudo apt-get install python-serial python-wxgtk2.8
python-pyglet python-tornado python-setuptools
python-1libxml2 python-gobject python-pip avahi-daemon
libavahi-compat-libdnssdl followed by: pip install -r
requirements.txt To install in a terminal issue the following
command: sudo python setup.py install. Run Printrun by
issuing the following command: python pronterface.py

Fedora

e Use this command to install Printrun from the official sources: sudo
yum install printrun

Archlinux

e Use this command to install Printun from AUR: yaourt rintrun

50



1.25. USING PRINTRUN

1.25 Using Printrun

P Printer Interface +_0OX
File Settings

Port Jdev/ttyAC| ¥ @| 115200 ¥ |Disconnei|Reset | Load file| Compose | SD Print Pause Co
Motors off XY: 3000 | mm/min Z: 200 : Connecting...

start
Printer is now online.
echo: External Reset
Marlin 1.0.0
echo: Last Updated: 2012-05-02 | Author: erik
Compiled: Nov 21 2012
echo: Free Memory: 4717 PlannerBufferBytes: 1232

echo:Using Default settings:
echo:SD card ok

[@HI

NS>/

Heat: Off 200.0 |~ | Set Checktemp Watch

Bed:| Off | 60 (pl| + | Set 300

Extruge| 5 |; mm 150 Graph offline
Reverse : m:’;‘f

+ Send

Figure 1.22: Printrun

Printrun is used to control the printer from a computer. It is divided into
4 main parts: The buttons over the top are used to connect to the printer,
load files and start & stop prints.

The movement controls are on the left hand side, with the G-code
preview window in the center and the Log window and Terminal command
entry box on the right hand side (Figure 1.22, page 51).

Connecting to the TAZ 3D Printer

To start up the printer, first you will need to connect to the printer with
Printrun. Make sure you have connected the USB cable from your PC
to the printer before launching Printrun. If not, close Printrun, connect
the USB cable, and relaunch Printrun. To connect to the printer, select
the correct port by using the drop down arrow and selecting the active
port, generally /dev/ttyACMO). On other operating systems the port may
be named such as COM1 or tty.usbserial-USB-ID. The Port button will
refresh the Port listing. Once selected choose the default 115200 buad rate
and press Connect. Pronterface will open a connection to the printer and
display firmware information in the Log window.
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In the text output window you will see multiple return lines. If you see
Printer is now online you have successfully connected to the printer.
The printer control buttons on the left will also darken and become click-
able after connecting. If nothing is displayed in the Log window verify you
have the correct port and connection speed selected. When you need to
disconnect the printer simply press the Disconnect button.

Printer Interface

File Settings
Port fdevifttyAC| ¥ @] 115200 ¥ |Disconnei| Reset | Load file|Compose |SD|  FPrint Pause Recower
Motors off XY: 3000 . mm/min Z: 200 : Connecting...

start

Printer is now online.

echo: External Reset

Marlin 1.0.0

echo: Last Updated: 2012-05-02 | Author: erik
Compiled: Nov 21 2012

echo: Free Memory: 4717 PlannerBufferBytes: 1232
echo:Using Default settings:

echo:SD card ok

< Z Axis mowvement

G-codg
B rishar
e e
Log window
Heat:| Off | 200.0 | v | Set |Check temp| | Watch
Bed:| Off |60 (pl| * | Set 200 .
Exctrude: A mm 150 Graph offline <- Temperature History
T 100
Reverse : mm/ gy
min v
+ Terminal Send
‘ 3

Figure 1.23: Printrun Functions
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Movement
Motors off
Heater: Off | 230 (Bb|' ‘Set Check temp‘
Bed: Off 110 (ablv Sat T:28.69 B:29.00
Extrude |5 mymm 200
Reverse |100 |IMm/minise Graph offline
7 Heater: T° 28/0)
-
T Bed:
Figure 1.24: Movement Controls
Motors off

The TAZ 3D printer can be moved on all three axes independently. If you
would like to do so by hand, use the Motors off button to unlock all the
stepper motors. Once unlocked they can be moved by hand. Keep in mind
that there is no positional feedback, so if you move an axis you will need
to re-home in order to re-establish the hot end’s position.

mm/min XY:/ Z:

These settings control the manual jog speeds when driven with Pronterface.
Use caution when changing these figures. Moving the axes too fast can
cause the printer to miss steps. If that occurs with the Z axis, it can
potentially cause the Z axis to become out of square.
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Homing

Caution: when homing, the axis will continue to move in the negative
direction until the end stop switch is activated. If the printer is ever
transported make sure the end stop switches are clear before resuming
printing. If an axis has missed an end stop and is continuing to try to
move in the negative direction, immediately turn the power switch to the
off position.

Each axes can be homed either individually or together. Press the Home
X button to move the X axis to the left until it activates the end stop. Once
the X axis end stop is activated, the X axis carriage will "bounce’- it will
move over and move back to the home position more slowly. Press the Home
Y button to home the Y axis. The Y axis platform will move away from
you towards the rear of the printer. The Z home button functions the same,
but the Z trigger cannot be adjusted manually on the printer and uses the
automatic bed-compensating routine at the beginning of each print.

X /Y /Z Axes Movement Controls

Prior to moving the X, Y, or Z axis, make sure that you home each axis.
The X, Y and Z axes can be moved utilizing the circular movement controls.
Each axis can be moved in either fine moves or large moves, ranging from
0.1lmm to 100mm. For example, to move the Y Axis towards you, move
your mouse to the +y section until both the +y and the 100 are highlighted
then select that ring section. To move the Y axis away from you, move
your mouse to the -y section until both the -y and the 100 are highlighted
then select that ring section. The X axis can be moved in a similar fashion.

The Z axis movement control operates similarly, but the movement scale
is different. The Z axis will move in 0.1mm, 1mm and 10mm increments.
The top half of the movement bar will move the Z axis up, by the selected
units, while the lower half will move the Z axis down, by the selected units.

1.26  CAD and 3D Modeling Software

LulzBot is not distributing a CAD or 3D modeling software package. How-
ever, multiple free/libre software packages are available. Other common
non-free CAD and 3D modeling software are also capable of exporting the
required .STL files.
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On some CAD and 3D modeling software you will need to select
millimeters as the output unit. If possible it is best to build your 3D design
in metric units rather than imperial units. Slic3r requires .STL files sized
in millimeters. If an .STL with inches as units is loaded into the Slic3r, the
model will be scaled much smaller than expected. You can scale the model
by 2540% to compensate. The software listed below outputs millimeters as
the unit by default.

FreeCAD

Website: http://free-cad.sourceforge.net

Although still in development, FreeCAD is a great free/libre CAD
application. Containing a full GUI for building CAD models, FreeCAD
is capable of creating simple to complex designs. STL files can also easily
be exported for use with 3D printing. FreeCAD is available for GNU /Linux,
Windows, and Mac. The latest development version is recommended.

OpenSCAD

Website: http://openscad.org

OpenSCAD is another free/libre CAD software; however, different than
FreeCAD, it is script based. Rather than using a GUI to generate CAD
designs, OpenSCAD CAD designs are created using script based renderings.
Users with programming experience would find this very useful. Also,
OpenSCAD uses a simple script language that is easy for users with little
or no programming experience to learn.

Blender

Website: http://blender.org

The most widely used free/libre 3D modeling software, Blender is well
documented with tutorials available on the Blender.org website as well as
found online.

Shapesmith

Website: http://shapesmith.net
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3D Printer Software

Shapesmith is a web-based 3D modeling software. This means there is
no required software to get started designing models. Shapesmith is also a
great choice for anyone starting out in CAD/ 3D modeling,.

1.27 Alternative Printer Host Software

OctoPrint

Website: http://octoprint.org/

Octoprint is a printer host that uses a web-based interface to access
and control the 3D printer. Added web-cam functionality allows for time-
lapse videos and a live stream. Octoprint will run on Windows, Apple and
Linux based computers and can even run well on a Beagle Bone Black or
a RaspberryPi (inexpensive business-card sized computers).

BotQueue

Website: https://www.botqueue.com/
Botqueue works well for those users wanting to have a web-based
multiple 3D printer operation running off a queuing system.

MatterControl

Website: http://www.mattercontrol.com/

MatterControl is another printer host that currently runs on Windows
and Apple computers. It features 2D and 3D model viewing, a print queue
and print file organization and searching.
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Slic3r

2.1 Introduction

Overview

Slic3r is a tool which translates digital 3D models into instructions that
are understood by a 3D printer. It slices the model into horizontal layers
and generates suitable paths to fill them.

Slic3r is already bundled with the many of the most well-known host
software packages: Pronterface, Repetier-Host, ReplicatorG, and can be
used as a standalone program.

This manual will provide guidance on how to install, configure and
utilize Slic3r in order to produce excellent prints.

This portion of the manual is derived from the complete Slic3r manual.
It has been customized for TAZ users. The original unabridged version can
be found at manual.slic3r.org.

Goals & Philosophy

Slic3r is an original project started in 2011 by Alessandro Ranellucci (aka.
Sound), who used his considerable knowledge of the Perl language to create
a fast and easy to use application. Readability and maintainability of the
code are among the design goals.

The program is under constant refinement, from Alessandro and the
other contributors to the project, with new features and bug fixes being
released on a regular basis.

Donating

Slic3r started as a one-man job, developed solely by Alessandro in his
spare time, and as a freelance developer this has a direct cost for him.
By generously releasing Slic3r to the public as open source software, under
the GPL license, he has enabled many to benefit from his work.

The opportunity to say thank you via a donation exists. More details
can be found at: http://slic3r.org/donations.
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2.2. GETTING SLIC3R

2.2  Getting Slic3r

Slic3r is Free Software, and is licensed under the GNU Affero General Public
License, version 3.

Downloading
From LulzBot

The Slic3r version that has been tested for the TAZ printer
can be downloaded from the LulzBot.com downloads page:
https://www.lulzbot.com/support/downloads.

Pre-compiled packages are available for Windows, Mac OS X and Linux.
Windows and Linux users can choose between 32 and 64 bit versions to
match their system.

Slic3r

Slic3r can be downloaded directly from: http://slic3r.org/download.
Pre-compiled packages are available for Windows, Mac OS X and Linux.

Windows and Linux users can choose between 32 and 64 bit versions to

match their system.

Manual

The latest version of full Slic3r manual, with IXTEX source code, can be

found at: https://github.com/alexrj/Slic3r-Manual

Source

The source code is available via GitHub: https://github.com/alexrj/Slic3r.
For more details on building from source see §2.2 below.

Installing
Linux

Extract the archive to a folder of your choosing. Either:
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o Start Slic3r directly by running the Slic3r executable, found in the
bin directory, or

« Install Slic3r by running the do-install executable, also found in the
bin folder.

The archive file may then be deleted.

Windows

Unzip the downloaded zip file to a folder of your choosing, there is no
installer script. The resulting folder contains two executables:

e slic3r.exe - starts the GUI version.
e slic3r-console.exe - can be used from the command line.

The zip file may then be deleted.

Mac OS X

Double-click the downloaded dmg file, an instance of Finder should open
together with an icon of the Slic3r program. Navigate to the Applications
directory and drag and drop the Slic3r icon into it. The dmg file may then
be deleted.

Building from source

For those wishing to live on the cutting edge, Slic3r can
be compiled from the latest source files found on GitHub
https://github.com/alexrj/Slic3r.

Up-to-date instructions for compiling and running from source can be
found on the Slic3r wiki.

2.3 First Print

Calibration

Your TAZ 3D printer was calibrated at the factory prior to packing. TAZ
users do not need to calibrate their printers.
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2.3. FIRST PRINT

If you are just beginning with 3D printing or Slic3r, LulzBot recom-
mends starting with our pre-set Slic3r profiles. You can find the TAZ
Slic3r profiles at https://www.lulzbot.com/support/downloads. For
information on loading and export Slic3r profiles please see page 115. Note
that the pre-set profiles will only work correctly when Slic3r is in Expert
mode.

The pre-set profiles will give you Slic3r settings that will work great on
most designs. The Slic3r manual can be used as a reference in building
knowledge of Slic3r settings while using the pre-set profiles. Once you have
a number of prints completed you can use the Slic3r manual as a reference
to make small adjustments to the pre-set profiles or begin creating your
own profiles.
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Configuration Wizard

Slic3r has two features to aid newcomers: the configuration wizard, and
simple mode.

Sometimes it is nice to have a helping hand when starting out with new
software. The configuration wizard asks a series of questions and creates a
new configuration for Slic3r.

When using the pre-set TAZ Slic3r profiles you do not need to complete
the Configuration Wizard. The Configuration Wizard can be later accessed
from the top menu once you are ready to start creating your own Slic3r
profiles.

Welcome to the Slic3r Configuration Assistant

o Welcome Hello, welcome to Slic3r! This assistant helps you with the initial
Firmware Type configuration; just a few settings and you will be ready to print.
Red Siza
Beg JI{'T‘ To import an existing configuration instead, cancel this assistant

Nozzle Diameter and use the Open Config menu item found in the File menu.
Filament Diameter
Extrusion Temperature To continue, click Next.
Bed Temperature

Finish

< Back Next = @gancel

Figure 2.1: Configuration Wizard: Welcome Screen
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2.3. FIRST PRINT

1. Firmware Type

The gcode produced by Slic3r is tailored to particular types of firmware.
The first step prompts for the firmware that the printer uses. For the TAZ
printer select RepRap (Marlin/Sprinter)

Firmware Type

e Welcome Choose the type of firmware used by your printer, then click Next.
o Firmware Type

Bed Size

N A Biametar G-code flavor: RepRap (Marlin/Sprinter| ¥
Filament Diameter
Extrusion Temperature
Bed Temperature
Finish
< Back Next = @gancei

Figure 2.2: Configuration Wizard: Firmware Type
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2. Bed Size

This setting defines the maximum distance the extruder may travel along
the X and Y axis. The dimensions for the TAZ print surface are X: 298
and Y: 275.

Be sure to measure from the lower left corner where the extruder nozzle
rests when are the home position to the maximum distance the nozzle can
travel in each direction. Take into account that the X carriage may touch
the frame before the nozzle reaches it’s full distance, this will depend on
the printer make and model.

Bed Size

e Welcome Enter the size of your printers bed, then click Next.
e Firmware Type
o Bed Size
N SR ametar Bed size: ®:| 298 y: mm
Filament Diameter
Extrusion Temperature
Bed Temperature

Finish

< Back Next = @Qancel

Figure 2.3: Configuration Wizard: Bed Size
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3. Nozzle Diameter

The diameter of the hot-end nozzle is usually clearly displayed either in the
description of the hot-end, or in the associated documentation, when the
hot-end is purchased. The nozzle sizes available for the TAZ hot end are
0.35mm and 0.50mm.

If the nozzle was home-made, or came from a source without a diameter
given, then carefully measure the aperture as accurately as possible. One
way of determining nozzle size is to very slowly (Imm/s) extrude some
filament into free air and measure the thickness of the resulting extrusion!.
This has the benefit of taking die swell into account, and consequently may
be a useful thing to do even if the diameter is known.

Nozzle Diameter

e Welcome Enter the diameter of your printers hot end nozzle, then click
e Firmware Type LEsE
@ Bed Size

o No T Nozzle diameter: mm
ament Diameter

Extrusion Temperature
Bed Temperature

nisn

< Back Next = @gancel

Figure 2.4: Configuration Wizard: Nozzle Diameter

U http://forums.reprap.org/read.php?1,113374,113953

65



Slic3r

4. Filament Diameter

For Slic3r to produce accurate results it must know as accurately as possible
how much material is pushed through the extruder. Therefore it is vital to
give it as precise a value as possible for the filament diameter.

Although the filament used in FDM printers is sold as being either
3mm or 1.75mm this is only a general guide. The diameter can vary
between manufacturers and even between batches. Therefore it is highly
recommended to take multiple measurements from along a length of the
filament and use the average. For example, measurements of 2.89, 2.88,
2.90 and 2.91 would yield an average of 2.895, and so this would be used.

Filament Diameter

& Welcome Enter the diameter of your filament, then click Next.
e Firmware Type
; Good precision is required, so use a caliper and do multiple
e Bed Size )
measurements along the filament, then compute the average.
@ Mozzle Diameter

@ Filament Diameter

Extrusion Temperature Diameter: 2.89| mm

Bed Temperature

Finish

= Back Mext > @gancel

Figure 2.5: Configuration Wizard: Filament Diameter
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5. Extrusion Temperature

The extrusion temperature will depend on the material, and most can
operate over a range of temperatures. The supplier should provide guidance
as to which temperatures are suitable. A very general rule of thumb is that
PLA lies between 160°C and 230°C, and ABS lies between 220°C and 240°C.
More exotic materials will have a different range.

This is one parameter which you will want to fine tune when you start
producing prints. The optimal temperature can vary even between colors of
the same material. Another factor which may affect the chosen temperature
is how fast the extrusion is, where generally faster extrusion runs hotter.

Note: One may choose to control the extruder temperature manually
from the printer controller. In this case the temperature can be set to zero.

Extrusion Temperature

Welcome Enter the temperature needed for extruding your filament, then

Firmware Type click Next.

Bed Size A rule of thumb is 160 to 230 °C for PLA, and 215 to 250 °C for
Nozzle Diameter ABS.

Filament Diameter
o Extrusion Temperature

. “ a
Bed Temperature Other layers: - °C

nisn

< Back Next = @Eancel

Figure 2.6: Configuration Wizard: Extrusion Temperature
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6. Bed Temperature

Slic3r

If the printer has a heated bed then this parameter may be set. As with
the extruder temperature, the value will depend on the material used. A
rule of thumb is that PLA requires 35°C - 60°C and ABS requires 85°C.

Note: One may choose to control the bed temperature manually from
the printer controller. In this case the temperature can be set to zero.

e Welcome

e Firmware Type

@ Bed Size

e Nozzle Diameter

e Filament Diameter

e Extrusion Temperature

= Bed Temperature
Finish

Figure 2.7:

Bed Temperature

Enter the bed temperature needed for getting your filament to
stick to your heated bed, then click Next.

A rule of thumb is 60 °C for PLA and 110 °C for ABS.

Other layers: 0 °C

< Back MNext =

Configuration Wizard: Bed Temperature
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2.3. FIRST PRINT

At this stage the wizard is complete and the basic configuration is

defined.

Congratulations!

e Welcome ‘You have successfully completed the Slic3r Configuration

s Firmware Type Assistant. Slic3r is now configured for your printer and filament.

® Bed Size To close this assistant and apply the newly created configuration,
® Nozzle Diameter click Finish.

e Filament Diameter

e Extrusion Temperature

e Bed Temperature

= Finish

< Back Finish @gancel

Figure 2.8: Configuration Wizard: End
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The Important First Layer

Before delving into producing the first print it is worthwhile taking a little
detour to talk about the importance of getting the first layer right. As
many have found through trial and error, if the first layer is not the best it
can be then it can lead to complete failure, parts detaching, and warping.
There are several techniques and recommendations one can heed in order
to minimise the chance of this happening.

Level bed. Having a level bed is critical. If the distance between the nozzle
tip and the bed deviates by even a small amount it can result in either the
material not lying down on the bed (because the nozzle is too close and
scrapes the bed instead), or the material lying too high from the bed and
not adhering correctly.

Higher temperature. The extruder hot-end and bed, if it is heated, can be
made hotter for the first layer, thus decreasing the viscosity of the material
being printed. As a rule of thumb, an additonal 5° is recommended.

Lower speeds. Slowing down the extruder for the first layer reduces the
forces applied to the molten material as it emerges, reducing the chances
of it being stretched too much and not adhering correctly. 30% or 50% of
the normal speed is recommended.

Correctly calibrated extrusion rates. If too much material is laid down
then the nozzle may drag through it on the second pass, causing it to lift
off the bed (particularly if the material has cooled). Too little material
may result in the first layer coming loose later in the print, leading either
to detached objects or warping. For these reasons it is important to have
a well-calibrated extrusion rate as recommended in §2.3).

First layer height. A thicker layer height will provide more flow, and
consequently more heat, making the extrusion adhere to the bed more. It
also gives the benefit of giving more tolerance for the levelness of the bed.
It is recommended to raise the first layer height to match the diameter of
the nozzle, e.g. a first layer height of 0.35mm for a 0.35mm nozzle. Note:
The first layer height is set this way automatically in simple mode.
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2.3. FIRST PRINT

Fatter extrusion width. The more material touching the bed, the better
the object will adhere to it, and this can be achieved by increasing the
extrusion width of the first layer, either by a percentage or a fixed amount.
Any spaces between the extrusions are adjusted accordingly.

A value of approximately 200% is usually recommended, but note that
the value is calculated from the layer height and so the value should only
be set if the layer height is the highest possible. For example, if the layer
height is 0.1mm, and the extrusion width is set to 200%, then the actual
extruded width will only be 0.2mm, which is smaller than the nozzle. This
would cause poor flow and lead to a failed print. It is therefore highly
recommended to combine the high first layer height technique recommended
above with this one. Setting the first layer height to 0.35mm and the first
extrusion width to 200% would result in a nice fat extrusion 0.65mm wide.

Bed material. Many options exist for the material to use for the bed, and
preparing the right surface can vastly improve first layer adhesion.

PLA is more forgiving and works well on PEI, PET, Kapton, or blue
painters tape.

ABS usually needs more cajoling and, whilst it can print well on PEI,
PET and Kapton, there are reports that people have success by applying an
ABS slurry (made from dissolving some ABS in Acetone) thinly applied can
also help keep the print attached. It’s generally preferred to print directly
on the PEI surface. At times a watered-down PVA or white school-glue
solution can help things adhere to the bed.

No cooling. Directly related with the above, it makes no sense to increase
the temperature of the first layer and still have a fan or other cooling
mechanism at work. Keeping the fan turned off for the first few layers is
generally recommended.
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Working with Models

Yet another step lies between now and the first print - a model has to be
obtained and then sliced.

Model Formats

Slic3r accepts the following file types.

o STereoLithography (STL) files can come from a wide variety of
sources and are now a de facto standard in 3D printing. The files
simply describe the surface geometry of a 3D object without any
additional information (such as color or material), and it is this
simplicity that has probably made the format ubiquitous.

o Wavefront OBJ files are an open format originally used in an ani-
mation application from Wavefront Technologies, but has since been
adopted by the wider 3D modelling community. It is similar to the
STL format.

o Additive Manufacturing File Format (AMF) was developed in re-
sponse to the limited nature of the STL format. In addition to
describing the geometry of the 3D model it can also describe colors
and materials, as well as more complex attributes, such as gradient
mixes and multiple object arrangements (constellations). Whilst the
format is deemed a standard it has yet to be widely adopted in the
3D maker community.

Finding Models

The 3D model files may come from an online repository, such as Thingi-
verse? or GrabCAD?, or be created from a CAD program, such as FreeCAD?,
Sketchup®, or OpenSCAD®, or an online CAD tool such as Shapesmith”.

http:/ /www.thingiverse.com
Shttp://grabcad.com

thttp:/ /sourceforge.net /projects/free-cad
http://www.sketchup.com
Chttp://www.openscad.org
"http://shapesmith.net
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You may wish to view the files before slicing and there are many free

applications available, one of which is Meshlab® - a comprehensive tool for
viewing and working with 3D files.

abc save import_. export .

help mydesigns signout garyhodgson

geometry , M workplane
v subtract B% © '

w cylinder &
x|10

y|9

z|0

rs

h 10

v cuboid T
%[0

y[-1

z|0

u|22

v |23

w10

Figure 2.9: Shapesmith online CAD tool.

Working with Plater

Slic3r has a tool, called Plater, which allows one or more models to be
loaded and arranged before being sliced.

$http://www.meshlab.org
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File Plater Window Help
Plater | Print Settings | Filament Settings | Printer Settings

@ @ & @ @ s L ]
Name Copies| Scale
Drag your objects here
Add... Autoarrange Export G-code..

Figure 2.10: Plater

Once you have acquired a model, drag it onto the Plater window (or use
the Add button below the file list) to load it into Slic3r. In the figure below,
the traditional RepRap Minimug? is loaded, and is viewed from above. The
ring around the model is a skirt - a single perimeter, several millimeters
away from the model, which is extruded first. This is useful in making sure
the plastic is flowing smoothly from the nozzle when the model is starting
to be printed.

Yhttp://www.thingiverse.com/thing:18357
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Figure 2.11: Minimug model.

File Plater Window Help

Plater Print Settings = Filament Settings | Printer Settings

e @ @ s L]
Maore Fewer 45° ccw  45° cw  Rotate... | Scale... Split
Name Copies Scale

Minimug.stl 1 100%

=]

=

—

I

b=

X =149

Add... Autoarrange Export G-code...
Delete Delete All Export STL...

Figure 2.12: STL file loaded.

The model can be repositioned by dragging the representation of it on
the left of the screen around the bed. Note that the dimensions of the

bed should match your printer, as given during the initial configuration
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above. Turn off ” Auto-center Parts” in Preferences to position parts where
desired. On the right-hand side is the list of currently loaded files. The
buttons along the top of the file list allow you to arrange the models.

« More/Less - Adjust how many copies should be printed.

« 45°/Rotate - Rotate the selected model around the Z axis, either in
45° increments clockwise or counter-clockwise, or by a given amount.

o Scale - Increase or decrease the size of the printed model.

o Split - Divides a model which consists of more than one part into it’s
constituent parts, allowing each one to be arranged individually.

» View/Cut - Provides a 3D view.

The buttons along the bottom of the file list allow you to add, remove,
auto-arrange, or export the models.

e« Add - Opens a file dialog to add a model to the plater, as an
alternative to dropping a file directly.

 Delete/Delete All - Remove one or all models from the plater.

o Autoarrange - Attempt to arrange the models to give the optimal
layout.

o Export G-code - Starts slicing the model and produces a G-Code file.

o Export STL - Save the current set of models as a single STL file.

Cleaning STLs

If the 3D mesh described in the model contains holes, or edges are
misaligned (known as being non-manifold), then Slic3r may have problems
working on it. Slic3r will attempt to fix any problems it can, but some
problems are out of its reach. If the application complains that a model
cannot be sliced correctly then there are several options available: see the
chapter about Repairing Models.
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Printing

At this stage Slic3r has been configured and a model has been acquired,
sliced and made ready for print. Now would be the time to fire up the
printer and try it out.

A variety of host software is available to send the G-code to the
printer. Amongst the open-source solutions are: Printrun!'’, Repetier!!
and Repsnapper'?.

The following subsections will cover the options available in expert
mode, and look at advanced printing techniques, including special cases
and troubleshooting.

2.4 Simple Mode

Simple Mode

Slic3r has two modes of operation, Simple and Expert. These may be
chosen from the Preferences window (found under the File menu).

General

Mode: Expert EI
@gance\ @QK

Figure 2.13: Preferences.

Simple mode offers a reduced set of options, enough for the beginner to
get started with. Expert mode gives more control over how Slic3r produces
the G-code and will be looked at later.

Print Settings

The Print Settings tab provides the opportunity to change settings
related to the actual print. Whereas the other tabs are changed rarely,
the settings on this tab will be modified regularly, possibly for each model
printed.

Ohttps://github.com/kliment /Printrun
Uhttp:/ /www.repetier.com/
2https://github.com/timschmidt /repsnapper
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File Plater Window Help

General

Layer height: 0.3 mm

Perimeters {(minimum): 2 :

Solid layers: Top:| 3 . Bottom:| 3
Infill

Fill density: 0.3

Fill pattern: rectilinear A

Support material

Generate support material:

Pattern spacing: 2.5 mm
Raft layers: 0 ~ layers
Speed

Perimeters: 30 mmy/s
Infill: 60 mmys
Travel: 130 mmy/s
Brim

Brim width: 0 mm

Seguential printing
Complete individual objects:
Extruder clearance {mm): Radius:| 20 Height:| 20

Want more options? Switch to the Expert Mode.

Figure 2.14: Simple Mode: Print Settings.

General. Layer height is the thickness of each layer, and it is the step
along the vertical axis taken before extruding a new layer atop the previous
one. There are several factors that influence how high each layer should

be:

e Desired resolution - Lower layer height should result in prints with
less noticeable ribs or bands, as each layer is smaller. Aesthetics plays
a role here, but also the type of model, for example, a mechanical part
may not need such a high resolution finish, whereas a presentation

piece may do so.
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o Print speed - Shorter layers will result in smoother prints but each
print will take longer, simply because the extruder must trace the
pattern more times. A later goal will be to strike a balance between
layer height, the speed of the printer, and the quality of the resulting
print.

Perimeters defines the minimum number of vertical shells (i.e. walls) a
print will have. Unless the model requires single width walls it is generally
recommended to have a minimum of two perimeters as this gives some
insurance that if a subsection of the perimeter is not printed correctly then
the second perimeter will help cover it.

The upper and lowermost layers that sandwich the model are filled with
a Solid layers pattern. For the bottom layers the important factor to
consider is how the surface will look should there be a mistake whilst laying
down the first layer, and for this reason it is recommended to have at least
two bottom layers.

A similar consideration is required for the top layers. Because the
intermediate layers are likely to be filled with a pattern set less than 100%
then the covering layers will have to bridge this pattern and this can require
more than one pass to cover completely.

Figure 2.15: An example of insufficient top layers.
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Another tip to consider: Setting the top solid layer to zero, and setting
the infill also to zero, will result in a hollow receptacle, ideal for turning
models into vases'® for example. Here manipulating the settings within
Slic3r can be used to generate different kinds of prints, and not only be
used to control surface accuracy.

Figure 2.16: Creating a vase from a solid model.

Infill. Fill density is defined on a scale of between 0 and 1, where 1 is
100% and 0.4 would be 40%. For the majority of cases it makes no sense to
100% fill the model with plastic, this would be a waste of material and take
a long time. Instead, most models can be filled with less material which is
then sandwiched between layers filled at 100% (see Solid layers above).

A density value of 0.4 is enough to give almost all models good
mechanical strength. A value of 0.2 is usually the minimum required to
support flat ceilings.

Slic3r offers several fill patterns which will be discussed in more depth
in subsection 2.5 - Infill Choices. Choosing a Fill pattern will depend
on the kind of model, the desired structural strength, print speed, and
personal taste. The more exotic fill methods are usually too slow and
unnecessarily complex for most use cases, and so most of the time the infill

Bhttp://slic3r.org/blog/tip-printing-vases
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pattern is either rectilinear, line, or honeycomb. Honeycomb gives the
most strength but is slower than both rectilinear or line.

Support material. Printing a model from the bottom up, as with FDM,
means that any significant overhangs will be printed in the air, and most
likely droop or not print correctly. Choosing support material (Generate
support material) will add additional structures around the model which
will build up to then support the overhanging part. The Pattern spacing
option determines how dense the support material is printed.

Figure 2.17: An example of an object printed with support material.

Tip: It is sometimes worth considering altering the orientation of the
model in order to possibly reduce overhangs.

Raft layers will add additional layers underneath the model and stems
from the early days of 3D printing. It can help with prints without a heated
bed, or where the bed is not very flat, but it is usually not required and is
not recommended. The raft also requires post-processing to remove it.

Speed. In simple mode there are only three speed settings to consider:

o Perimeters - The outline of the model may benefit from being
printed slightly slower so that the outside skin of the print has fewer
blemishes.
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o Infill - As the infill is hidden this can be extruded a little faster.
Take care though not to go too fast as higher speeds results in thinner
extrusions, and this may affect how the extrusions bond.

e Travel - The jump between the end of one extrusion and the next
should usually be performed as quickly as the printer will allow in
order to minimise any mess caused by material oozing from the nozzle.

Brim. Brim width is used to add more perimeters to the first layer, as a
base flange, in order to provide more surface area for the print to stick to
the bed with in order to reduce warping (see §2.3). The brim is then cut
away once the print is finished and removed from the bed.

Figure 2.18: An example of brim.

Sequential Printing. This feature allows to compose a plate of objects but
have the printer complete each one individually before going back to Z
= 0 and starting with the next one. See the subsection about Sequential
Printing in the Advanced Topics chapter.

Filament Settings

The Filament Settings will normally be used infrequently, for example
on receipt of a new roll of filament.
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File Plater Window Help
Plater | Print Settings | Filament Settings | Printer Settings

Filament
Diameter: 2.89 mm
Extrusion multiplier: 1

Temperature (*C)
Extruder: First layer: O < Other layers: 0
Bed: First layer:| 0 . Other layers:| 0

Want more options? Switch to the Expert Mode.

Figure 2.19: Simple Mode: Filament Settings.

Filament. The Diameter setting will already have been filled from the
value given during the wizard (see p.66), but can be updated here.

The Extrusion multiplier setting allows the fine tuning of the
extrusion flow rate, and is is given as a factor, e.g. 1 means 100%, 1.5
would mean 150%. Whilst the value should ideally be set in the firmware
it can be useful to test slight changes to the rate by altering this value. It
varies the amount of plastic proportionally and should be changed in very
small steps (e.g. +/- 0.05) as the effects are very visible.

Temperature. These values are also filled from the wizard, but here the
opportunity exists to set the temperature for the first layer (see p.70).

Printer Settings

The Printer Settings will be updated the least, unless Slic3r is going to
be used for many printers, for example, in a 3D printer farm.
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File Plater Window Help
Plater | Print Settings | Filament Settings | Printer Settings

Size and coordinates

Bed size: x: 298 | y: 280 'mm
Print center: x: 149 | y: 140 'mm

Z offset: 0 mm

Firmware

G-code flavor: RepRap (Marlin/Sprinter| ¥
Extruder

Nozzle diameter: 0.35 mm
Retraction

Length: 1.6 mm (zero to disable)
Lift Z: 0 mm

Start G-code

G28 ; home all axes

End G-code

M400

M104 SO ; turn off nozzle temperature
M140 SO ; turn off bed temperature
G1Y280

G28 X0 ; home X axis

M84 ; disable motors

Want more options? Switch to the Expert Mode.

Figure 2.20: Simple Mode: Printer Settings.

Size and coordinates. The Bed size setting is taken from the wizard (see
p.64) and is only used for previewing the model in the plater.

The Print center is the point around which the print will be centered.
A Bed size of 200mmx200mm and a Print center of 100mmx100mm
would sit the print in the middle. Should it be desired to print away from
the center, because of a scratch in the glass perhaps, then this option should
be used.

Z offset can be used to compensate for an incorrectly calibrated Z
end-stop. If the nozzle stops slightly too far from the bed, then adding a
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negative value will offset all layers by that amount. The correct solution
however is to fix the end-stop itself.

The optimal Z endstop position is where the nozzle tip barely touches
the surface of the bed when homed. A sheet of paper makes a good gauge
for this very small distance. It is not recommended to use this setting to
try and improve layer adhesion, by "squashing” the bottom layer into the
bed, instead look at the suggestions in subsection 2.3.

Firmware. As selected in the wizard (see p.63), G-code flavour defines
the dialect of G-code generated.

Extruder. Nozzle diameter was defined in the wizard (see p.65).

Retraction. Unless the material being extruded has a very high viscosity
it may ooze between extrusions due to gravity. This can be remedied by
actively retracting the filament between extrusions. Setting the Length
parameter to a positive value will cause the filament to be reversed by that
many millimeters before travel. The retraction will then be compensated
for by the same amount after the travel move, before starting the new
extrusion path.

A value of between 1 and 2mm is usually recommended. Bowden
extruders may need up to 4 or 5mm due to the hysteresis introduced by
the tube. Setting the Lift Z parameter to a positive value will raise the
entire extruder on the Z axis by that many millimeters during each travel.
This can be useful to ensure the nozzle will not catch on any already laid
filament, however it is usually not necessary and will slow the print speed.
A value of 0.1mm is usually sufficient.

Start, End and Layer Chance G-codes. Custom G-code commands can be
run before a print starts and after a print finishes.

Placeholders can be inserted in the G-code commands'. For example
[next_extruder| would return the index of the next extruder.

The RepRap wiki is a good resource to learn about the variety of G-
codes available: http://reprap.org/wiki/G-code.

Note: Be sure to check that a given G-code is valid for your firmware.

Yhttps: //github.com/alexrj/Slic3r/wiki/FAQ#what-placeholders-can-i-use-in-
custom-g-code
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The codes specified in Start G-code are inserted at the beginning of the
output file, directly after the temperature control commands for extruder
and bed. Note that if temperature control commands are specified (M104
and M190) then these will replace the temperature G-codes introduced by
the Filament settings.

Some common G-codes to use before the print starts are:

o G28 - Homes all the axes.
Some common G-codes to use after the print ends are:
e M104 SO - Sets the extruder temperature to zero.

M140 SO - Sets the heated bed temperature to zero.

G28 X0 - Home the X axis.

MR&4 - Disables the motors.

2.5 Expert Mode

Speed

Once the printer is reliably producing good quality prints it may be
desirable to increase the speed. Doing this provides several benefits, the
most obvious of which is that the results are produced quicker, but also
faster print times can be utilised in producing more layers, i.e. lower layer
height, thus improving perceived print quality. An additional benefit is
that a faster travel movement, between extrusions, can reduce the effects
of oozing.

The best approach is to increment the various speed parameters in
small steps and observe the effect each change has on print quality. Travel
speed is a safe starting point, and it is not unrealistic to attain speeds
of up to 250mm/s (if your printer can handle it). Adjusting the speed of
perimeters, infill is available in simple mode, and the general rule is to have
the perimeter go a little slower than the infill in order to reduce possible
blemishes on the surface (infill can be faster because slight gaps will not
matter as much).

Expert mode offers more parameters to fine tune printer speeds. Dif-
ferentiation between external, small and other perimeters, infill locations,
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and bridges and gaps are available, as well as the ability to slow down for
the first layer.

Speed for print moves

Perimeters: 90 mmy/s
Small perimeters: 40 mmy/s or %
External perimeters: 70 mmy/s or %
Infill: 100 mmy/s
Saolid infill: 100 mmy/s or %
Top solid infill: 50% mmy/s or %
Support material: 60 mmy/s
Bridges: 60 mmy/s
Gap fill: 40 mmy/s

Speed for non-print mowves

Travel: 150 mmy/s
Modifiers
First layer speed: 50% mmy/s or %

Acceleration control (advanced)

Perimeters: 0 mmy/s?
Infill: 0 mmy/s?
Bridge: 0 mmy/s?
Default: 0 mmys?

Figure 2.21: Expert mode speed options.

Where indicated a value can be given in percentage. This is in relation
to the preceding value, e.g. 50% solid infill would be half of the value
defined for infill.

A few general guidelines for each option:

e Perimeters - In expert mode this parameter can be increased slightly
as the External perimeters option can be used to ensure blemish
free external faces.
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e Small perimeters - Meant for holes, islands and fine details, a slower
speed here is recommended.

o External perimeters - A slightly slower value may ensure cleaner
surfaces.

o Infill - Asfast as you can without compromising the integrity of the
fill structure. Faster extrusions can break and result in weak spots.

e Solid infill - The bottom of the model, and any additional solid
layers is usually slightly slower than infill but faster than perimeters.

e Top solid infill - Allow time for the extrusion to cleanly cover
the previous top layers and result in a tidy top surface. The last few
layers should have bridged the infill structure nicely, preparing the
way for a neat finish.

e Support material - Generally support structures are quick and dirty;,
and so long as the base is adequately supported they can be built as
quickly as they can.

e Bridges - Having the extrusion span distances depends on the
material and cooling. Going too slow will result in sagging, too fast
will result in broken strands. Experimentation is the key here, but
generally bridging runs slower than perimeters.

e Gap fill - Filling in small gaps results in the extruder quickly
oscillating and the resulting shaking and resonance could have a
detrimental affect on the printer. A smaller value here can guard
against this. A setting of zero disables gap filling completely.

o Travel - As fast as your printer will allow in order to minimise ooze.

o First layer speed- As mentioned in subsection 2.3, the first layer is
important to lay down correctly, and a slower pace helps enormously.
Setting a value of 50%, or even less, can really help.

Acceleration control is an advanced setting allowing acceleration
settings for perimeters, infill, bridge, as well as a default setting, to be
made. Deciding which values to set depends on the capabilities of the
machine. Any settings within the firmware may be a good starting point.
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Take into account any restrictions enforced by the firmware as many
have settings for the maximum safe speed of each axis.
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Infill Patterns and Density

There are several considerations when choosing an infill pattern: object
strength, time and material, personal preference. It can be inferred that a
more complex pattern will require more moves, and hence take more time
and material.

Infill

Fill density:

Fill pattern: line x
Top/bottom fill pattern: rectilinear x

Figure 2.22: Infill pattern settings.

Slic3r offers several infill patterns, four regular, and three more exotic
flavours. The numbers given in brackets below each figure are a rough
estimate of material used and time taken for a simple 20mm cube model®.
Note that this is only indicative, as model complexity and other factors
will affect time and material.

Figure 2.23: Infill pattern: Line (344.51mm / 5m:20s)

Figure 2.24: Infill pattern: Rectilinear (350.57mm / 5m:23s)

P Taken from http://gcode.ws
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Figure 2.25: Infill pattern: Concentric (351.80mm / 5m:30s)

Figure 2.26: Infill pattern: Honeycomb (362.73mm / 5m:39s)

A\

Figure 2.27: Infill pattern: Hilbert Curve (332.82mm / 5m:28s)

Figure 2.28: Infill pattern: Archimedean Chords (333.66mm / 5m:27s)
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Figure 2.29: Infill pattern: Octagram Spiral (318.63mm / 5m:15s)

Certain model types are more suited for a particular pattern, for exam-
ple organic versus mechanical types. Figure 2.30 shows how a honeycomb
fill may suit this mechanical part better because each hexagon bonds with
the same underlying pattern each layer, forming a strong vertical structure.

oNaXe

Figure 2.30: Infill pattern comparison in a complex object. Left to Right:
honeycomb, line

Most models require only a low density infill, as providing more than,
say, 50% will produce a very tightly packed model which uses more material
than required. For this reason a common range of patterns is between 10%
and 30%, however the requirements of the model will determine which

density is best. Figure 2.31 shows how the patterns change as the density
increases.
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Infill Optimization

Slic3r contains several advanced infill settings which can help produce
better extrusions.

Advanced
Infill every: 2 - layers

Only infill where needed:

Solid infill every: 0 * layers
Fill angle: 45 2
Solid infill threshold area: 70 mm?

Only retract when crossing

¢ v
perimeters:

Infill before perimeters:

Figure 2.32: Infill advanced settings.

e« Infill every n layers - Will produce sparse vertical infill by
skipping a set number of layers. This can be used to speed up print
times where the missing infill is acceptable.

e Only infill where needed - Slic3r will analyse the model and
choose where infill is required in order to support internal ceilings
and overhangs. Useful for reducing time and materials.

e Solid infill every n layers - Forces a solid fill pattern on the
specified layers. Zero will disable this option.

e Fill angle - By default the infill pattern runs at 45° to the model to
provide the best adhesion to wall structures. Infill extrusions that run
adjacent to perimeters are liable to de-laminate under stress. Some
models may benefit from rotating the fill angle to ensure the optimal
direction of the extrusion.

e Solid infill threshold area - Small areas within the model are
usually best off being filled completely to provide structural integrity.
This will however take more time and material, and can result in
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parts being unnecessarily solid. Adjust this option to balance these
needs.

e Only retract when crossing perimeters - Retracting, to prevent
ooze, is unnecessary if the extruder remains within the boundaries
of the model. Care should be taken if the print material oozes
excessively, as not retracting may result in enough material loss to
affect the quality of the subsequent extrusion. However, most modern
printers and materials rarely suffer from such extreme ooze problems.

e Infill before perimeters - Reverses the order in which the layer
is printed. Usually the perimeter is laid down initially, followed by
the infill, and this is usually the preferable as the perimeter acts as a
wall containing the infill.

Fighting Ooze

Unless the material being extruded has a very high viscosity it will ooze
from the nozzle in between extrusions. There are several settings in Slic3r
to which can help to remedy this.

The retraction settings, found in the Printer tab, tell the printer to pull
back the filament between extrusion moves. This can alleviate the pressure
in the nozzle, thus reducing ooze. After the subsequent travel move the
retraction is reversed to prepare the extruder for the next extrusion.

Retraction

Length: 1.6 mm (zero to disable)
Lift Z: 0 mm

Speed: 40 . mmjs

Extra length on restart: 0 mm

Minile.lm travel after 2 mm

retraction:

Retract on layer change: v

Figure 2.33: Retraction settings.
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e Length - The number of millimeters to retract. Note that the
measurement is taken from the raw filament entering the extruder.
A value of between 1 and 2mm is usually recommended. Bowden
extruders may need up to 4 or 5bmm due to the hysteresis introduced
by the tube.

o« Lift Z - Raises the entire extruder on the 7Z axis by that many
millimeters during each travel. This can be useful to ensure the nozzle
will not catch on any already laid filament, however it is usually not
necessary and will slow the print speed. A value of 0.1mm is usually
sufficient.

o Speed - The speed at which the extruder motor will pull back the
filament. The value should be set to as quick as the extruder can
handle without skipping steps, and it is worth experimenting with
this value to find the quickest retraction possible.

o Extra length on restart - Adds an extra length of filament after
the retraction is compensated after the travel move. This setting
is rarely used, however should the print show signs of not having
enough material after travel moves then it may be useful to add a
small amount of additional material.

e Minimum travel after retraction - Triggering a retraction after
very short moves is usually unnecessary as the amount of ooze is
usually insignificant and it slows down the print times. Set the
number of millimeters minimum distance the nozzle must move before
considering a retraction. If the printer handles ooze well this can be
increased to 5 or 6mm.

e Retract on layer change - Movement along the Z axis must also
be considered when dealing with oozing, otherwise blobs may occur.
It is recommended to leave this setting on.

e Wipe before retract - Moves the nozzle whilst retracting so as to
reduce the chances of a blob forming.

Additionally there are several settings in the Print tab which can help
control oozing.
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Only retract when crossing perimeters (Infill) - Tells Slic3r to
only retract if the nozzle will cross the threshold of the current island
being extruded. Slight ooze within the walls of a part are not seen
and can usually be accepted.

Avoid crossing perimeters (Layers and perimeters - Advanced)
- Will force the nozzle to follow perimeters as much as possible
to minimise the number of times it must cross them when moving
around, and between, islands. This has a negative impact on both
G-code generation and print times.

Randomize starting points (Layers and perimeters - Vertical shells)
- As the extruder moves up to the start of the next layer any ooze can
result in blobs. If the same start point is used for every layer then a
seam can form the length of the object. This setting will move the
start point to a different location for each layer.

See also subsection: Sequential Printing, on page 118 for another
technique which can minimise strings forming between objects.

Skirt

The

Skirt setting adds an extrusion a short distance away from the

perimiter of the object. This can ensure that the material is flowing
smoothly from the extruder before it starts on the model proper.

Skirt

Loops: 2 :
Distance from object: 6 mm
Skirt height: 1 . layers
Minimum extrusion length: 0 mm

Figure 2.34: Skirt settings.

Loops - How many circuits should be completed before starting on
the model. One loop is usually sufficient.
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e Distance from object - The millimeters between the object and
the skirt. The default of 6mm is usually sufficient.

e Skirt height - The number of layers to lay down a skirt for. For
ensuring the material is flowing smoothly, one layer is sufficient,
however the skirt function can also be used to build walls around
the object in case it should be protected from drafts.

e Minimum extrusion length - Dictates a minimum number of mil-
limeters that the skirt should be, should the loop around the object
not be enough.

Cooling

Temperature plays a key part in determining print quality. Too hot and
the material deforms, too cool and layer adhesion may be problematic.
Applying cooling will allow the freshly deposited material to solidify enough
to provide a good base for the next layer, helping with overhangs, small
details and bridges.

There are two main techniques for cooling: adding a fan and slowing
down the print speed. Slic3r may choose to use both techniques, using a
fan first, and then slowing down the print if the layer time is too fast.
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#1 threshold #2 threshold

THEN
o DS s
SLOWDOWN FIRSTENABLE THEFAN -+

0,
print speed 100%

73,

n

S'OGG'O/

min print speed
min fan speed

estimated layer time

Figure 2.35: Cooling strategy.

Figure 2.35 shows the strategy adopted by Slic3r. Reading from right
to left, when the minimum fan threshold (#2) is reached the fan is turned
on. This increases in intensity as the layer time decreases. The print
speed remains constant until the estimated print time drops below a certain
threshold (#1), this is when the print speed is reduced until it reaches it’s
minimum value.

Fans

Most electronics and firmware allow the addition of a fan via a spare
connector. These can then be instructed with G-code, from Slic3r, to turn
on or off as the model requires, and to rotate at different speeds.

Care should be taken with the positioning of the fan so that it does
not cool any heated bed more than necessary. It should also not cool the
heater block of the hot-end so as not to force it to do more work and waste
energy. The air movement should aim for the nozzle tip, flowing over the
freshly extruded material.
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A duct may help in guiding the flow correctly, and there are several
designs available online, for a wide variety of printers.

Slowing Down

Slic3r can tell the printer to slow down if the estimated layer time is above
a certain threshold.

Care must be taken as the intended effect could be mitigated by the
nozzle not moving far enough away from the fresh extrusion, a problem
with small, detailed layers. For this reason it is usually recommended to
use a fan where possible.

Configuring

In simple mode Slic3r will attempt to choose the optimal settings for both
fans and speed. Expert mode gives more granular options.

File Plater Window Help
Plater | Print Settings = Filament Settings | Printer Settings

config-200s.ini i|=]| €| Enable

Enable cooling: v
@ Filament

If estimated layer time is below ~20s, fan will run at 100%
and print speed will be reduced so that no less than 20s are
spent on that layer (however, speed will never be reduced
below 15mmy/s).

If estimated layer time is greater, but still below ~60s, fan
will run at a proportionally decreasing speed between 100%
and 35%.

During the other layers, fan will be turned off.

Fan settings

Fan speed: Min:| 35 2 Max: 100 .
Bridges fan speed: 100 %
Disable fan for the first: 1 . layers

Keep fan always on:

Cooling thresholds

Enable fan if layer print time is below: 60 approximate seconds

Ar 4

Slow down if layer print time is below: 20 approximate seconds

Min print speed: 15 - mm/s

Figure 2.36: Cooling advanced settings.
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e Fan speed - Determines the minimum and maximum speeds - useful
for fans that run too fast by default.

e Bridges fan speed - As the material stretches over wide gaps, it
makes sense to try and cool it as much as possible, therefore a full
fan speed is recommended.

o Disable fan for first n layers - Section 2.3 detailed how
important the first layer is, and so it makes sense not to apply the
fan until sure the print is securely attached to the bed. Keeping the
fan turned off for the first two or three layers is a good idea.

e Keep fan always on - Overrides any other choices and has the fan
run continuously, at least at the minimum speed setting. This can be
useful when printing with PLA, but is not recommended for ABS.

e Enable fan if print time is below t seconds - Triggers the fan
if the layer will be completed within the given number of seconds.

e Slow down if layer print time is below t seconds - Slows
down the print if the layer will be completed within the given number
of seconds.

e Min print speed - A lower limit on how slowly a layer can be printed.

Support Material

Generally, most 3D models will print with overhanging parts by up to a
certain degree. The angle is determined by several factors, most notably
layer height and extrusion width, and is usually around 45°. For models
with larger overhangs a support structure may have to be printed below it.
This incurs the use of more material, longer print times, and post printing
clean-up.
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File Plater Window Help
Plater  Print Settings | Filament Settings | Printer Settings
config-200s.ini (modit| |[=]| & Support material

@ Layers and perimeters Generate support material: ¥/}
Infill Overhang threshold: 45 .
£) Speed Enforce support for the first: |0 > layers
[3 Skirt and brim
L5l Support material Raft
| Motes Raft layers: 0 > layers
= Output options
¥ Multiple Extruders Options for support material and raft
47 Advanced Pattern: rectilinear -
Pattern spacing: 25 mm
Pattern angle: 0 :
Interface layers: 0 > layers
Interface pattern spacing: 0 mm

Figure 2.37: Support structure options.

The first thing to do is activate the support material option by checking
the Generate support material box. Providing a value of zero to the
Overhang threshold parameter tells Slic3r to detect places to provide
support automatically, otherwise the degrees given will be used. Support
generation is a relatively complex topic, and there are several aspects
which determine the optimal support, it is strongly recommended to set
the threshold to zero and allow Slic3r to determine the support required.

Small models, and those with small footprints, can sometimes break or
detach from the bed. Therefore the Enforce support option will cause
support structures to be printed for the given number of layers, regardless
of the angle threshold value.

To demonstrate the infill patterns the minimug model was tilted by 45°
along the x axis, as shown in figure 2.38.
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Figure 2.38: Minimug model, tilted 45°.

As with infill, there are several patterns available for the support

structure.
Figure 2.39: Support infill pattern: Rectilinear
t:? %

Figure 2.40: Support infill pattern: Rectilinear Grid
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Figure 2.41: Support infill pattern: Honeycomb

Pattern Spacing determines the distance between support lines, and
is akin to infill density apart from being defined only in mm. If changing
this attribute take into account the width of the support extrusion and the
amount of support material that will adhere to the object.

Care should be taken to choose a support pattern which matches the
model, where the support material attaches perpendicularly to the wall of
the object, rather than in parallel, so it will be easy to remove. If the
support structure does run along the length of a wall then the Pattern
Angle option allows the direction of the support lines to be rotated.

7

-_—,

%

Figure 2.42: Example of pattern angle rotated 45°.

Multiple Extruders

A printer with more than one extruder can be used in different ways: The
additional extruder could print a different color or material; or it could be
assigned to print particular features, such as infill, support or perimeters.
Multi-material printing requires a suitably designed object usually
written in AMF format as this can handle multiple materials (see Model
Formats in §2.3). Details on how to create such a file are given below.
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Configuring Extruders

In the Printer Settings tab there is an Extruders option, under
Capabilities, which allows the number of extruders to be defined. In-
crementing this value will dynamically add another extruder definition to
the left-hand pane.

File Plater Window Help

Plater | Print Settings | Filament Settings

- default - {|[&l| @ | [Size and coordinates
(=) General Bed size: x: 200 | y: 200 |mm
i Custom G-code Print center: x: 100 | y: 100 |mm
W Extruder 1 Z offset: 0 mm
Firmware
G-code flavor: RepRap (Marlin/Sprinter/Repe| =

Use relative E distances:

Capabilities

Extruders: 1 :
Advanced

Vibration limit: 0 Hz

Figure 2.43: Multiple extruder options - Printer Settings Tab (General).
Note the two extruders defined in the left-hand pane.

Each extruder can be configured as usual, however there are additional
settings which must be set which are particular to multi-extruder setups.

Position (for multi-extruder printers)

Extruder offset: x:| 0 y: 0 mrm

Retraction when tool is disabled (advanced settings for multi-extruder setups)
Length: 10 mm (zero to disable)

Extra length on restart: 0 mm

Figure 2.44: Multiple extruder options - Printer Settings Tab (Extruder).
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The Extruder offset is to be used should the firmware not handle
the displacement of each additional nozzle. Your firmware documentation
should tell you if this is the case. Each additional extruder is given an
offset in relation to the first one. If the firmware does handle this then all
offsets can remain at 0,0. We recommend that TAZ users set the extruder
offset in Slic3r.

Because the secondary extruder will be dormant whilst the first is
working, and vice-versa, it is important that the material is sufficiently
retracted to stop oozing. As with the regular retraction settings (see p.95)
the Length options is measured from the raw filament entering the extruder.

Assigning Filaments

When a printer profile with multiple extruders has been selected the Plater
tab allows the selection of a different filament for each extruder.

File Plater Window Help
Plater | Print Settings | Filament Settings | Printer Settings
@ @ ] @ @ e i
More ewe 15% cow 15% cw Rotate.. acale.. aplit
Name Copies| Scale
Drag your objects here
Add... Autoarrange Export G-code
Print settings: | - default - Filament: Printer: - default - (modified) :
- default - :

Figure 2.45: Plater with multiple filament options.

Assigning Extruders for Single-material Objects

For single material prints, where the secondary extruder is to be tasked with
a particular extrusion, the Multiple Extruders subsection of the Print
Settings tab gives the ability to assign an extruder to each extrusion type.
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File Plater Window Help

Plater  Print Settings | Filament Settings | Printer Settings

- default - ||| € Extruders
@ Layers and perimeters Perimeter extruder: 1
Infill Infill extruder: 1
) Speed

(=) Skirt and brim Support material extruder: 1

1al Support material

LR I B Y

Support material interface
extruder:

| Notes

Figure 2.46: Multiple extruder options - Print Settings Tab.

Configuring Tool Changes

The Custom G-code subsection of the Printer Settings tab has an option
for inserting G-code between tool changes. As with all custom G-code
subsections, placeholder variables can be used to reference Slic3r settings.
This includes the [previous_extruder| and [next_ extruder| variables.

Tool change G-code

Figure 2.47: Multiple extruder options - Tool change G-code.
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Printing Multi-material Objects

If a multi-material AMF file already exists, because the CAD program can
export such a format, then this can be loaded into Slic3r in the usual way.
The mapping between object materials and extruders is sequential, i.e. the
first material is assigned to the first extruder, etc.

Generating multi-material AMF files

Slic3r has the feature to combine multiple STL files into a multi-material
AMF file.

o Split the original design into the separate parts within the CAD
program, and export each part as STL.

o Within Slic3r, choose Combine multi-material STL files... from
the File menu.

o When prompted with a file dialog, choose the first STL, which will
be assigned the first material (and hence the first extruder). Click
Open to be prompted for the next STL, and so on until each STL is
assigned a material. To signal there are no more STL files, choose
Cancel.

o The following file dialog prompts for the location and name of the
AMTF file.

Once generated the file can be loaded and printed as described above.
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Extrusion Width

File Plater Window Help
Plater Print Settings = Filament Settings | Printer Settings
config-200s.ini (modit |[&]| & Extrusion width

. Default extrusion width: .315 mm or % (leave 0 for auto)
@ Layers and perimeters
Infill First layer: .315 mm or % (leave 0 for default)
(&) Speed Perimeters: 0 mm or % (leave 0 for default)
Q Skirt and brim Infill: .35 mm or % (leave 0 for default)
Ll Support material Solid infill: 0 mm or % (leave O for default)
| Notes
: Top solid infill: .3 mm or % (leave 0 for default)
= Output options
7 Multiple Extruders Support material: 0 mm or % (leave 0 for default)
.~ Advanced
Flow
Bridge flow ratio: 1
Other
Threads: 2 . [more speed but more memory usage)
Resolution: 0 mm

Figure 2.48: Extrusion widths options.

One reason for modifying the extrusion width has already been discussed:
increasing first layer extrusion width in order to improve bed adhesion (see
p.71). There are some further cases where it may be beneficial to modify
extrusion widths.

e Perimeter - A lower value will produce thinner extrusions which in
turn will produce more accurate surfaces.

e Infill and Solid Infill - A thicker extrusion for infill will produce
faster prints and stronger parts.

e Top infill - A thinner extrusion will improve surface finish and
ensure corners are tightly filled.

o Support material - As with the infill options, a thicker extrusion
will speed up print time.
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It is important to remember that if the extrusion width is expressed as
a percentage then this is computed from the Layer height property, and
not the Default extrusion width setting.

Variable Layer Height

Slic3r gives the ability to adjust the layer height between arbitrary positions
along the Z axis. That is, parts of the model could be printed with a
coarse layer height, for example vertical subsections, and other parts could
be printed with a finer layer height, for example sloping gradients where
layering appears more pronounced.

The model in fig. 2.49 gives a rudimentary example of where variable
layer heights could be used to improve print quality. The walls of the
structure need not be rendered in high definition for acceptable quality,
however the sloping roof shows layer artifacts as the layer height of 0.4mm
is too coarse, particularly for the very top, which is flattened. This is shown
in the G-Code rendering in fig 2.50.

Figure 2.49: Example model highlighting use case for variable layer heights.
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Figure 2.50: Example with normal layer height.

The variable layer height options are available by double clicking on a
part name in the Plater window. This will cause a pop-up window to be
displayed which contains two tabs. The first gives some information about
the model, as shown in fig. 2.51.
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Info | Layers
Name: Twisted Vase Basic.stl
Size: 100.00 x 99.97 x 200.00
Facets: 124
Vertices: 64

Materials: 1

Shells: 1
Volume: 1227788.00
Degenerate facets: 0

Edges fixed:

0
Facets removed: 0
Facets added: 0
Facets reversed: 0
Backwards edges: 0

Figure 2.51: Variable layer height options - Info.

It is worth noting the height of the model, as this will be useful when
calculating the maximum 7 height.

The second tab (fig. 2.52) presents a table where each row defines a
layer height for a particular range along the Z axis, given in millimeters.
In this example the walls of the model are printed at 0.4mm, the steeper
parts of the roof are printed at 0.2mm, and the less steep at 0.15mm. Note
that each range divides exactly by the given layer height so there are no
"gaps” between subsections.
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Info  Layers

You can use this section to override the default layer height for parts of this
nhiect. Set laver heinht to zern to skin nortions of the innut file.

Min Z (mm) Max Z (mm) ‘Layer height (mm]‘
0 4 0.4
4 8.4 0.2

80 09

BlW N =

<Jok

Figure 2.52: Variable layer height options - Layers.

The resulting G-Code (fig. 2.53) shows a higher definition which should
result in a higher quality print.

Figure 2.53: Example with variable layer height.
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Fig. 2.54 shows the example model printed. The print on the left has
0.4mm layer height throughout, whereas the print on the right has the
variable layer height.

Figure 2.54: Example print with variable layer height.

An additional feature of the variable layers height option is that by
entering a zero for a range that part of the model will not be printed. Fig.
2.55 shows the G-Code where layers between 0 and 4mm are skipped. This
is a useful way of dividing a tall model into multiple, shorter subsections
which can be printed individually and assembled afterwards.

Figure 2.55: Example with skipped layers.
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2.6 Configuration Organization

There are two ways in which to organize the configuration settings: export-
ing and importing the configuration settings, and profiles. The former is
available in both simple and expert mode, whereas profiles is only available
in expert mode.

Exporting and Importing Configuration

The current set of configuration options can be simply exported via the
Export Config File menu option. This saves all the values into a text file
with a .ini extension. Previously saved files can be loaded with the Load
Config menu option.

This gives a rudimentary means to store different configuration settings
for different needs. For example a set with slightly faster print speeds, or a
different infill pattern. However this way of organizing things will quickly
become frustrating, as each minor change to a parameter may have to be
duplicated across many configurations. For this reason, profiles are a more
suitable way of managing multiple configurations.

This method also allows configuration to be transferred between ma-
chines, or stored remotely.

Profiles

After a few prints it will become apparent that it is worth having a set
of configuration options to choose from, and that some parameters change
at different rates as others. In expert mode, profiles can be created for
Print, Filament and Printer settings, with the expectation that the printer
settings change least often, filament rarely, and the print settings could be
changed for each model. These different profiles can be mixed and matched
as desired, and can be selected either in their respective tabs, or directly
from the plater.

Creating Profiles

Open the desired tab and change the settings as necessary. Once satisfied,
click the save icon to the left above the setting titles, and give a suitable
name when prompted.
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@ Slic3r
File Plater Window Help

Plater Print Settings  Filament Settings | Printer Settings

config-200s.ini {mod Extrusion width

. Default extrusion width: 31t
@ Layers and perimeters

% Infill _ First layer: 31¢
i
© Speed Sa-.re preset * X 0

[ Skirt and brim Save print settings as: 35
Lzl Support material| | config-200s v 5
Mot
I Notes | @Qancel & oK 3
= Output options

' Multiple Extruders AL 1] 5 0

W _

Figure 2.56: Saving a profile.

Profiles can be deleted by choosing the profile to delete and clicking the
red delete button next to the save button.

r Slic3r
File Plater Window Help

Plater Print Settings | Filament Settings | Printer Settings
config-200s : Extrusion width

. Default extrusion width: 315 mm ¢
@ Layers and perimeters

7 Infill First layer: .315 mm ¢
) Speed Perimeters: 0 mm ¢
(3 Skirt and brim Infill: .35 mm ¢
Lal Support material Solid infill: 0 mm ¢
| Notes o

Top solid infill: 3 mm ¢

= Dbt antinns

Figure 2.57: Deleting a profile.
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2.7 Repairing Models

If the 3D mesh described in the model contains holes, or edges are
misaligned (known as being non-manifold), then Slic3r may have problems
working on it. Slic3r will attempt to fix any problems it can, but some
problems are out of its reach. If the application complains that a model
cannot be sliced correctly then there are several options available, and the
ones described here are all free at the time of writing.

FreeCAD Freecad!'¢ is a comprehensive, and free, CAD program which
comes with a mesh module, in which repairs to degenerate models can be
made. The following steps outline how a problem model file can be analysed
and repaired.

Ry FreeCAD [ES=] )
File Edt View Tools Mscro Meshes Windows Help
BEL s [0 -o-CEmmen -0 e =20 QHIIY BHI S 220w
8 x Evaluate &Repai Mesh s
Mesh nformation
e e—l
Namber ofedges: 10
M perimeter-... refiesh Number ofpons:
=
hodvze | | e
pdyze | [ Repar
e =
-
pdyze | [ Repar
podyze || e
] nsurface pdyze | | e
Al shove tests together
a Analyze Repair
ier e | [ Swtrore ] B mors:
418434470 mm

Figure 2.58: FreeCAD part repair.

o Start FreeCAD and from the start splash page choose Working with
Meshes.

e Load the model by dragging and dropping it onto the workspace or
via the File menu. A small message in the bottom left corner will
indicate if the model appears to have problems.

http:/ /sourceforge.net /projects/free-cad
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e From the menu choose Meshes->Analyze->Evaluate & Repair mesh
to bring up the repair options dialog.

o From the options dialog choose the loaded mesh, then perform each
analysis be clicking the Analyze button by each problem type, or
select Repetitive Repair at the bottom to perform all checks. If
a corresponding problem is detected the Repair button becomes
enabled.

« For each desired repair hit the Repair button.

o It is important to review the effect the repair script has made to the
model. It may be the case that the script damages the file, rather
than repair, for example by removing important triangles.

o Export the repaired model via the Export menu option or context
mentu.

2.8 Advanced Topics

Sequential Printing

When printing several objects at once it can be useful to print each one
separately as this will minimise oozing and strings running between the
prints. It will also decrease the risk of a problem ruining the entire print -
if one part detaches or fails in some way, it will not be dragged into other
parts of the print during each layer.

Sequential printing

Complete individual objects: [l
Extruder clearance (mm): Radius: 20 Height: 20

Figure 2.59: Sequential printing options.

Care has to be taken that the nozzle and extruder does not interfere
with already printed parts. Slic3r should warn if it detects the nozzle or
extruder will collide with a part, but double check that the layout of the
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parts will not cause problems. The Extruder clearance parameters help
Slic3r detect potential collisions:

e Radius - The clearance that should be given around the extruder.
Take care if the extruder is not mounted centrally - take the largest
safe value, generally 80mm.

o Height - The vertical distance between the nozzle tip and the X axis
rods, or lowest part which may interfere with a finished print.

Figure 2.60: The clearance cylinder around an extruder.
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Command Line Usage

Slic3r can also be used from the command line instead of via the GUI, as
part of a script, or as part of another tool, such as Printrun'’.

All options found in the GUI can be used from the command line in the
form of switch parameters. The latest version of these are given below, and
the most up-to-date information can be found by issuing the command:

perl slic3r.pl --help

Preset configurations can be loaded from a .ini file using the --load
option, and options can be overridden further on the command line, e.g.

perl slic3r.pl --load config.ini --layer-height 0.25
file.stl

Command Line Options

Usage: slic3r.pl [ OPTIONS ] file.stl

--help Output this usage screen and exit

--version Output the version of Slic3r and exit

--save <file> Save configuration to the specified file

--load <file> Load configuration from the specified file. It can be used
more than once to load options from multiple files.

-0, -—output <file> File to output gcode to (by default, the file will be saved

into the same directory as the input file using the
--output-filename-format to generate the filename)
-j, -—threads <num> Number of threads to use (1+, default: 2)

GUI options:
--no-plater Disable the plater tab
--gui-mode Overrides the configured mode (simple/expert)

Output options:
--output-filename-format
Output file name format; all config options enclosed in brackets
will be replaced by their values, as well as [input_filename_base]
and [input_filename] (default: [input_filename_base].gcode)

--post-process Generated G-code will be processed with the supplied script;

call this more than once to process through multiple scripts.
--export-svg Export a SVG file containing slices instead of G-code.
-m, --merge If multiple files are supplied, they will be composed into a single

print rather than processed individually.

Printer options:
--nozzle-diameter Diameter of nozzle in mm (default: 0.5)

--print-center Coordinates in mm of the point to center the print around
(default: 100,100)
--z-offset Additional height in mm to add to vertical coordinates

(+/-, default: 0)

Thttps://github.com /kliment /Printrun
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--gcode-flavor The type of G-code to generate
(reprap/teacup/makerbot/sailfish/mach3/no-extrusion, default: reprap)
--use-relative-e-distances Enable this to get relative E values

--gcode-arcs Use G2/G3 commands for native arcs (experimental, not supported
by all firmwares)

--g0 Use GO commands for retraction (experimental, not supported by all
firmwares)

--gcode-comments Make G-code verbose by adding comments (default: no)

--vibration-limit Limit the frequency of moves on X and Y axes (Hz, set zero to disable;
default: 0)

Filament options:
—--filament-diameter Diameter in mm of your raw filament (default: 3)
--extrusion-multiplier
Change this to alter the amount of plastic extruded. There should be
very little need to change this value, which is only useful to
compensate for filament packing (default: 1)
--temperature Extrusion temperature in degree Celsius, set O to disable (default: 200)
--first-layer-temperature Extrusion temperature for the first layer, in degree Celsius,
set 0 to disable (default: same as --temperature)
--bed-temperature Heated bed temperature in degree Celsius, set O to disable (default: 0)
--first-layer-bed-temperature Heated bed temperature for the first layer, in degree Celsius,
set 0 to disable (default: same as --bed-temperature)

Speed options:
--travel-speed Speed of non-print moves in mm/s (default: 130)
—-perimeter-speed Speed of print moves for perimeters in mm/s (default: 30)
--small-perimeter-speed
Speed of print moves for small perimeters in mm/s or % over perimeter speed
(default: 30)
-—external-perimeter-speed
Speed of print moves for the external perimeter in mm/s or % over perimeter speed
(default: 70%)
--infill-speed Speed of print moves in mm/s (default: 60)
--solid-infill-speed Speed of print moves for solid surfaces in mm/s or ¥ over infill speed
(default: 60)
--top-solid-infill-speed Speed of print moves for top surfaces in mm/s or J over solid infill speed
(default: 50)
--support-material-speed
Speed of support material print moves in mm/s (default: 60)
--bridge-speed Speed of bridge print moves in mm/s (default: 60)
--gap-fill-speed Speed of gap fill print moves in mm/s (default: 20)
--first-layer-speed Speed of print moves for bottom layer, expressed either as an absolute
value or as a percentage over normal speeds (default: 30%)

Acceleration options:
--perimeter-acceleration
Overrides firmware's default acceleration for perimeters. (mm/s”2, set zero
to disable; default: 0)
--infill-acceleration
Overrides firmware's default acceleration for infill. (mm/s”2, set zero
to disable; default: 0)
--bridge-acceleration
Overrides firmware's default acceleration for bridges. (mm/s”2, set zero
to disable; default: 0)
--default-acceleration
Acceleration will be reset to this value after the specific settings above
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have been applied. (mm/s”2, set zero to disable; default: 130)

Accuracy options:
--layer-height Layer height in mm (default: 0.4)
--first-layer-height Layer height for first layer (mm or %, default: 0.35)
--infill-every-layers
Infill every N layers (default: 1)
--solid-infill-every-layers
Force a solid layer every N layers (default: 0)

Print optionms:
--perimeters Number of perimeters/horizontal skins (range: 0+, default: 3)
--top-solid-layers Number of solid layers to do for top surfaces (range: O+, default: 3)
--bottom-solid-layers Number of solid layers to do for bottom surfaces (range: 0+, default: 3)

--solid-layers Shortcut for setting the two options above at once

--fill-density Infill density (range: 0-1, default: 0.4)

--fill-angle Infill angle in degrees (range: 0-90, default: 45)

--fill-pattern Pattern to use to fill non-solid layers (default: honeycomb)

--solid-fill-pattern Pattern to use to fill solid layers (default: rectilinear)

--start-gcode Load initial G-code from the supplied file. This will overwrite
the default command (home all axes [G28]).

--end-gcode Load final G-code from the supplied file. This will overwrite

the default commands (turn off temperature [M104 SO],

home X axis [G28 X], disable motors [M84]).
--layer-gcode Load layer-change G-code from the supplied file (default: nothing).
--toolchange-gcode Load tool-change G-code from the supplied file (default: nothing).
--extra-perimeters Add more perimeters when needed (default: yes)
--randomize-start Randomize starting point across layers (default: yes)

--avoid-crossing-perimeters Optimize travel moves so that no perimeters are crossed (default: no)
--external-perimeters-first Reverse perimeter order. (default: no)
--only-retract-when-crossing-perimeters
Disable retraction when travelling between infill paths inside the same island.

(default: no)

--solid-infill-below-area
Force solid infill when a region has a smaller area than this threshold

(mm~2, default: 70)
--infill-only-where-needed

Only infill under ceilings (default: no)
--infill-first Make infill before perimeters (default: no)

Support material options:
--support-material Generate support material for overhangs
--support-material-threshold
Overhang threshold angle (range: 0-90, set O for automatic detection,
default: 0)
--support-material-pattern
Pattern to use for support material (default: rectilinear)
--support-material-spacing
Spacing between pattern lines (mm, default: 2.5)
--support-material-angle
Support material angle in degrees (range: 0-90, default: 0)
--support-material-interface-layers
Number of perpendicular layers between support material and object
(0+, default: 0)
--support-material-interface-spacing
Spacing between interface pattern lines
(mm, set O to get a solid layer, default: 0)
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--raft-layers Number of layers to raise the printed objects by (range: 0+, default: 0)
--support-material-enforce-layers
Enforce support material on the specified number of layers from bottom,
regardless of --support-material and threshold (0+, default: 0)

Retraction options:
--retract-length Length of retraction in mm when pausing extrusion (default: 1)
--retract-speed Speed for retraction in mm/s (default: 30)
—--retract-restart-extra
Additional amount of filament in mm to push after
compensating retraction (default: 0)
--retract-before-travel
Only retract before travel moves of this length in mm (default: 2)
--retract-lift Lift Z by the given distance in mm when retracting (default: 0)
--retract-layer-change
Enforce a retraction before each Z move (default: yes)
--wipe Wipe the nozzle while doing a retraction (default: no)

Retraction options for multi-extruder setups:
--retract-length-toolchange
Length of retraction in mm when disabling tool (default: 1)
--retract-restart-extra-toolchnage
Additional amount of filament in mm to push after
switching tool (default: 0)

Cooling options:

--cooling Enable fan and cooling control
--min-fan-speed Minimum fan speed (default: 35%)
--max-fan-speed Maximum fan speed (default: 100%)

--bridge-fan-speed Fan speed to use when bridging (default: 100%)
--fan-below-layer-time Enable fan if layer print time is below this approximate number
of seconds (default: 60)
--slowdown-below-layer-time Slow down if layer print time is below this approximate number
of seconds (default: 30)
--min-print-speed Minimum print speed (mm/s, default: 10)
--disable-fan-first-layers Disable fan for the first N layers (default: 1)
--fan-always-on Keep fan always on at min fan speed, even for layers that don't need
cooling

Skirt options:

--skirts Number of skirts to draw (0+, default: 1)
--skirt-distance Distance in mm between innermost skirt and object
(default: 6)
--skirt-height Height of skirts to draw (expressed in layers, O+, default: 1)

--min-skirt-length Generate no less than the number of loops required to consume this length
of filament on the first layer, for each extruder (mm, O+, default: 0)
--brim-width Width of the brim that will get added to each object to help adhesion
(mm, default: 0)

Transform options:

--scale Factor for scaling input object (default: 1)

--rotate Rotation angle in degrees (0-360, default: 0)

--duplicate Number of items with auto-arrange (1+, default: 1)
--bed-size Bed size, only used for auto-arrange (mm, default: 200,200)

--duplicate-grid Number of items with grid arrangement (default: 1,1)
--duplicate-distance Distance in mm between copies (default: 6)
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Sequential printing options:
--complete-objects When printing multiple objects and/or copies, complete each one before
starting the next one; watch out for extruder collisions (default: no)
--extruder-clearance-radius Radius in mm above which extruder won't collide with anything
(default: 20)
--extruder-clearance-height Maximum vertical extruder depth; i.e. vertical distance from
extruder tip and carriage bottom (default: 20)

Miscellaneous options:
--notes Notes to be added as comments to the output file
--resolution Minimum detail resolution (mm, set zero for full resolution, default: 0)

Flow options (advanced):
--extrusion-width Set extrusion width manually; it accepts either an absolute value in mm
(like 0.65) or a percentage over layer height (like 200%)
--first-layer-extrusion-width
Set a different extrusion width for first layer
--perimeter-extrusion-width
Set a different extrusion width for perimeters
--infill-extrusion-width
Set a different extrusion width for infill
--solid-infill-extrusion-width
Set a different extrusion width for solid infill
--top-infill-extrusion-width
Set a different extrusion width for top infill
--support-material-extrusion-width
Set a different extrusion width for support material
--bridge-flow-ratio Multiplier for extrusion when bridging (> 0, default: 1)

Multiple extruder options:

--extruder-offset O0ffset of each extruder, if firmware doesn't handle the displacement
(can be specified multiple times, default: 0x0)

--perimeter-extruder
Extruder to use for perimeters (1+, default: 1)

--infill-extruder Extruder to use for infill (1+, default: 1)

--support-material-extruder
Extruder to use for support material (1+, default: 1)
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Post-Processing Scripts

There may be times when the G-Code generated by Slic3r has to be tweaked
or modified after it has been created. For this reason there exists the ability
to run arbitrary scripts as part of the final steps in the slicing process'®.
In the Output options subsection of the Print Settings tab lies the
Post-processing scripts option. The absolute path to each script can
be added, separated by semicolons. Each scripts should be recognised by

the host system, and be executable.

= Output options Output filename format: [input_filename_base].gcode
' Multiple Extruders

g~ Advanced Post-processing scripts

C\Tools\Slic3rutils\post-processing\filament-weight.p|

Figure 2.61: Post-processing script option.

Each script will be passed the absolute path of the G-Code file that
Slic3r generates. All Slic3r configuration options are made available to the
scripts by way of environment variables. These all begin with SLIC3R_.
The following script would write out all Slic3r options to standard output:

#!/bin/sh
echo "Post-processing G-code file: $x"
env | grep “SLIC3R

Figure 2.62: Example post-processing script to display Slic3r environment
variables.

Example scripts can be found in the GitHub repository'?.

Perl’s in-place mode (perl -i) makes it easy to modify the contents
of the G-Code file, without having to copy, edit, then replace the original.
The following example will simply output the contents to standard output:

Bhttps://github.com/alexrj/Slic3r/wiki/Writing-post-processing-scripts

Yhttps://github.com/alexrj/Slic3r/tree/master/utils/post-processing
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#!/usr/bin/perl -i
use strict;
use warnings;

while (<>) {
# modify $_ here before printing
print;

Figure 2.63: Example post-processing script to print each line to output.
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Understanding extrusion width

Two main questions affect Slic3r’s work:

o How distant should extrusion paths be positioned in order to get a
good continuous finish?

o How much material must be extruded along such paths?

If two adjacent paths are too close (or too much material is extruded),
they’ll overlap. If two adjacent paths are too distant (or not enough
material is extruded), gaps will be visible and/or the extrusions will
delaminate because of not enough bonding.

By extruding more or less while moving (i.e. by changing the flow
speed /head speed ratio) we can make paths thicker or thinner:

Layer
height

B

Extrusion width

Figure 2.64: Extrusion Width.

Thicker paths will have better bonding with the lower layer, thus are
good for mechanical parts. However, they’ll be less able to approximate
the object shape and fill tiny gaps or narrow curves (think of a drill bit: a
larger one will not be able to enter narrow places). On the contrary, thinner
paths will provide less bonding but better shape accuracy.

However note that extrusion width can be controlled only when extrud-
ing over an existing surface (such as a previous layer or print bed). If we
extrude in free air (i.e. when bridging), the resulting shape will be always
round and equal to the nozzle diameter:
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Figure 2.65: Bridging filament shape.

If you reduce the material flow you’ll get smaller circles to some extent,
until the plastic viscosity decides it’s time to break your bridge because of
too much tension. If, on the contrary, you extrude too much material, the
shape of the extruded filament won’t change (still equal to nozzle diameter)
but you'll get a loose bridge.

Let’s start from a definition:

Extrusion Width is the thickness of a single filament extruded either in
free air or above a surface. It’s not the distance of two adjacent
paths since some overlap will be generally applied in order to get
better bonding.

Bridges: the easy case

As said above, there’s only one correct flow rate for bridging: the one that
doesn’t make your bridge sag or break. Extrusions are round and their
diameter is equal to the nozzle diameter. Parallel paths will be positioned
so that they are tangent, thus the spacing between one path and its neighbor
is equal to nozzle diameter as well. (In case of bridges, we want no overlap
because it has proven to drag the existing paths.)

The required material volume for a path of unitary length is calculated
accordingly to the cylindric shape, thus with a circular cross-sectional area:

E = (nozzle diameter/2)\textasciicircum{2} * Pi

Extruding on top of a surface

In this case the problem is: what shape will our extrusion get? We know
it will get squashed horizontally, but will it have a rectangular or oval
shape? What’s the maximum extrusion width we can get with a given
nozzle diameter before plastic starts curling at the sides?

Slic3r assumes that the cross-sectional shape of an extrusion is a
rectangle with semicircular ends. So the relationship between desired
extrusion width and volume to extrude is the following:
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2

Figure 2.66: Extrusion shape.

When target extrusion width is thinner than layer height the shape is
unpredictable so we just use the same rectangular formula but discourage
usage of such thin extrusion values.

The above formula provides a function that correlates the target extru-
sion width with the amount of material to extrude per distance unit:

E = f(extrusion width layer_height)

Spacing paths

How much should we overlap paths in order to get perfect bonding?
Supposing no overlap, thus tangent paths, there would be empty space
(yellow):

Figure 2.67: No path overlap

The cross-section area of such voids is generally:
void area = layer height\"{2} - (layer height/2)\"{2} * PI
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Ideally, we would want to fill all of that yellow area by placing the
extrusions closed to each other. However, it’s very unlikely that the second
extrusion will fill the space below the previous one, so there would still be
a little void. The ideal overlap would be something like:

0 < overlap factor * void area < void area with overlap
factor ranging from 0 to 1. Overlap factor represents how much void
remains between the extrusions. It’s difficult to estimate this amount,
since it probably depends also on viscosity of plastic, extrusion speed and
temperature. In the past, several values were tried for overlap factor, but
some users were still reporting too sparse paths. A value of 1 is currently
being used to guarantee that the error (which is always present) is fully on
the side of abundant extrusion rather than lacking material.

Path spacing is thus:

spacing = extrusion width - layer height * (1 - PI/4)

Sane defaults

Slic3r allows users to define extrusion width manually for each kind of
extrusion (perimeters, infill, support material etc.) but will calculate
sane defaults if no custom values are entered. For the outermost loop of
perimeters (aka external perimeters) Slic3r will default to a thin extrusion
width, equal to

nozzle diameter * 1.05.

This is considered the thinnest safe extrusion width. A thin extrusion
width provides better accuracy to the object shape and minimizes the flow
errors caused by irregular filament.

Extrusion width for other things is calculated by getting the cross-
sectional area of the configured nozzle diameter and then calculating the
extrusion width produced by extruding that amount of material. In
other words, by matching flow speed and head speed. The purpose of
this logic is to find the "native” flow that minimizes side forces during
extrusion. Such calculated extrusion with is capped to max value equal to:

nozzle diameter * 1.7, except for internal sparse infill where the full
native flow is used.
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2.9 Troubleshooting

Dimension Errors

Your TAZ 3D printer has been calibrated and tested prior to leaving our
Colorado factory: the steps/mm values for X, Y, and Z axes have been
calculated according to your belts, pulleys and leadscrews. Please don’t
calibrate by trial-and-error: those values should be exact. Use our standard,
known-good values already present in the firmware.

Vertical dimensions

If your vertical dimensions are wrong (i.e. along the Z axis) -and your
object is usually shorter than expected- it means your nozzle is too low,
thus the first layer is pressed too much on the print bed. To fix this, you
might want to raise your Z endstop or increase the Z offset option in Slic3r.

If you encounter vertical dimensions that are half the expected
height, make sure that you are using the appropriate firmware for
your 3D printer. Instructions on firmware flashing can be found at:
https://www.LulzBot.com/Cura.

Horizontal dimensions

The usual issue is about holes being too small. This usually only affects
holes on the horizontal plane (XY). There are several reasons for this. Let’s
see them one by one:

Plastic shrinkage

Plastic shrinks when cooling. Different kinds of plastic exhibit different
shrinkage rates, which might also depend on temperature. Because of such
shrinkage, circular (or polygonal) holes laid by the extruder at the nominal
diameter will end up smaller after cooling.

More material is deposited in the inside

When you extrude along a curve, more material per distance unit is
deposited in the concave side. Such excessive material makes the internal
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radius shorter. A compensation algorithm® was proposed by Adrian
Bowyer, and it was implemented in Slic3r some time ago but many users
complained about holes being too large — it was removed thereafter since
smaller holes are better than larger holes since they can be drilled.

Curves are approximated by polygons

STL files only contain meshes composed by flat triangles, so its planar
sections can only contain polygonal shapes. For example, a circular hole is
approximated by a polygon:

Figure 2.68: Holes made through polygonal segments.

Increasing the number of segments in your CAD before exporting the
STL file will help reducing the error. OpenSCAD users might want to
use the polyhole() function developed by nophead?! that calculates the
optimal number of segments.

Filament tends to cut corners

Since curves are approximated by polygons, there are sharp vertices at their
vertices. However, plastic tends to make rounded corners, thus reducing
the internal area of the hole even more.

Mhttp://reprap.org/wiki/ArcCompensation
Hhttp://hydraraptor.blogspot.it/2011/02/polyholes.html
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Z wobble

Even if the dimensional accuracy of a single layer was correct, several
stacked layers might make the hole smaller if they’re not exactly aligned.
7 wobble caused by mechanical issues will reduce hole size to the internal
envelope of the stacked layers:

Figure 2.69: Z wobble changing layer stacking.

Non-regular filament section

Low-quality and medium-quality filaments are not very regular in diameter.
If you measure their diameter along a single meter of them, you’ll often
find many different values (and many low-quality filaments are even not
perfectly round in section). This continuous variation in diameter will
produce irregular flow and the resulting hole will still be the internal
envelope of all the layers:

——

Figure 2.70: Variable filament diameter changing layer stacking.
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Backlash

Backlash is a mechanical defect of one or more axes that basically reduces
the amount of actual motion whenever a motor inverts its spinning direction.
It’s generally caused by loose belts. On printers with a moving bed, its axis
(usually Y) is more subject to backlash because of inertia. So, if you get
different dimension errors in X and Y, that’s caused by backlash. You’ll
need to tighten your belts.

Flow Math

The above causes do not depend on Slic3r and, when possible, they need
to be fixed before attempting any software solution.

That said, the flow math used in Slic3r plays a good role in making
correct dimensions, since it tries to guess what the shape of the extruded
material will be and how thick the extrusion will result on the horizontal
plane given an amount of material. Being an approximation, it carries an
error. The usual way to deal with these issues involves tuning the Extrusion
Multiplier setting in order to increase/reduce the amount of plastic, thus
making extrusions more or less thick. But this will also affect solid surfaces,
so it’s not the ideal solution.

For more exact dimensions you need to check the External Perimeters
First option. Printing external perimeters first will prevent the shift caused
by extrudate overlap. On the other hand, printing internal perimeters first
hides seams better, so it’s your take.

A new XY Size Compensation option was also introduced that allows to
grow /shrink object shapes in order to compensate for the measured error.
Supposing your holes are smaller by 0.lmm, you can just enter -0.05 in
this option to get them compensated (negative sign means shrink inwards).
This is not recommended.

7. Wobble

Undulations in the walls of a print may be due to wobble in the Z axis.
A thorough analysis of the potential causes is given by whosawhatsis* in

his article "Taxonomy of Z axis artifacts in extrusion-based 3d printing”?3,

http://goo.gl/i0YoK
Bhttp://goo.gl/cidGz
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however one point of particular interest for users of Slic3r is the wobble
caused by motor steps not matching the pitch of the Z rods thread. This
can be addressed by ensuring the Layer Height setting is a multiple of the
full step length.

The relevant part of the above paper is quoted here:

To avoid Z ribbing, you should always choose a layer height
that is a multiple of your full-step length. To calculate the full-
step length for the screws you're using, take the pitch of your
screws (I recommend M6, with a pitch of lmm) and divide by
the number of full-steps per rotation on your motors (usually
200). Microsteps are not reliably accurate enough, so ignore
them for this calculation (though using microstepping will still
make them smoother and quieter). For my recommended M6
screws, this comes out to 5 microns. It’s 4 microns for the M5
screws used by the i3, and 6.25 microns for the M8 screws used
by most other repraps. A layer height of 200 microns (.2mm),
for example, will work with any of these because 200 = 6.25 *
32 =5 %40 =4 * 50.
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2.10  Slic3r Support

Slic3r Support

A variety of resources are available to provide support for Slic3r.

Wiki and FAQ

The wiki provides up-to-date documentation, and a FAQ sub-
section which may help resolve any queries or issues.

e https://github.com/alexrj/Slic3r/wiki/Documentation
e https://github.com/alexrj/Slic3r/wiki/FAQ

Blog

The Slic3r blog contains tips, hints, and advice.

e http://slic3r.org/blog

IRC

Found on the irc.freenode.net server, the following chat
rooms are often filled with people who can provide real-time
help:

o #reprap: Highly active community of the RepRap project
with many users of Slic3r.

e #s1ic3r: Slic3r chat room where Slic3r developers and
users can provide help.

RepRap.org Forum

The RepRap forums contain a dedicated forum for Slic3r.

o forums.reprap.org/list.php?7263
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Issue Tracker

If you find a bug in the software, then raise the issue in the
project issue tracker.

e github.com/alexrj/Slic3r/issues

Please take the time to read through the existing issues to
see whether the problem has already been submitted. Also
make sure that the problem is a bug in the application; do
not submit support related questions here. If the bug appears
to be unreported then please read the bug report guide before
submitting: http://git.io/11Hy_w.
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Printing with the Graphic LCD

The Graphic LCD allows you to print with the TAZ 3D printer without
needing to have a computer connected or using host software such as
Printrun. This will allow for more efficient space in the workspace and
free up a computer for other tasks.

In the following sections you will find general information on using the
Graphic LCD, how to transfer .gcode files to the included SD card, heat
up the printer, start a print, and make configuration adjustments.

3.1 GLCD Controller, Cura or Printrun Host?

The Graphical LCD Controller is perfect for normal day to day printing and
will be used in the majority of your print jobs. However, in some instances-
you will want to use Cura or Printrun instead of the GLCD Controller. A
few examples of when you would want to plug the USB cable back in and
use Cura:

e A number of manual movements are required to perform calibration
checks. Because of this it is easier and faster to make the required
manual movements within Cura. Calibration checks can be done with
the Graphic LCD, but require a number of repetitive menu selections.

o Printrun offers a number of extra options for advanced users, including
custom gcode input, output display, and pronsole. Pronsole is the
command line portion of Printrun that can be used in scripts for au-

tomation or controlling a printer through remote access, for example,
SSH.

o Cura is the preferred printer host software, as the inclusion of quick
print profiles, the combination of slicing engine, and printer host
communications allows for easy all-in-one use.

3.2 Multiple Connections

Because the TAZ 3D printer can be controlled by the Graphic LCD and by
host software, caution is advised when connecting to the printer through
USB as the print can be interrupted when connecting or disconnecting the
USB cable. A general rule is: once you have started a print with either
the Graphic LCD, Cura, or Printrun, for the rest of the print use only that
controller. When printing with the Graphic LCD, never try to connect
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through USB in the Cura host software; wait until the print is complete,
and then connect in Cura.

3.3 Putting Print Files on the SD Card

To print from the Graphic LCD, you will need to transfer .gcode print
files onto the SD card. Follow the normal steps, as explained in the Slic3r
chapter, to create .gcode print files on your computer. Insert the SD card
into your computer using a SD reader slot or USB SD card reader. Open a
file browser- / -manager and locate the created .gcode files; drag and drop
or paste the .gcode files to the SD card. Once the files have transferred,
eject the SD card from your computer and insert it back into the SD card
slot on the left side of the Graphic LCD case.

"IIL B
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Figure 3.1: GLCD Info Screen
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3.4 Printing With the Graphic LCD

The Graphic LCD Status Screen

The GLCD screen will turn on you power up your TAZ 3D printer. The
start-up screen will display the Status screen (fig. 3.1, page 141). The
Status screen is the default screen for the GLCD, presenting the current
status of the printer. There are a number of live statuses shown on
the Status screen; these will give you current temperatures, tool head
coordinates, print status, and more. The different numbered sections of
the status screen are shown in Figure 3.1 above. Follow the key below for
more information on each section.

1.

Hot end temperatures: represents the current temperature (bottom)
and set temperature (top) of up to three nozzles. The RAMBo control
electronics currently only supports two hot ends.

. Heat bed temperature: represents the current temperature (bottom)

and set temperature (top) of the heat bed.

Fan speed: represents the current optional extruder fan speed. The
fan is set to off (1%) by default; the fan is not recommended for ABS.
If you print with PLA filament, you will want to use the fan. If cooling
is turned on in Cura/Slic3r, this portion of the display will change to
reflect the .g-code embedded extruder fan control instructions.

Tool head coordinates: represents the current tool head coordinates
on the X, Y, and Z axes.

Feed rate: represents the current feed rate setting. The feed rate is set
to 100% by default; this matches the speed set in the gcode generation.
When on, the status screen selection knob can be turned to increase
or decrease the feed rate during the print. Increasing/decreasing the
feed rate will increase/decrease the speed of the print.

Printer status: lists the current status of the printer including: SD
card status, current printing file, or completed print time.

Current print time: lists the length of time for the current print job.

8. Progress bar: represents the progress of the current print job. The

print is finished when the bar is completely white.
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Using the Selection Knob

To navigate through the LCD menu use the selection knob by rotating
to scroll through selections and pressing the knob to make a selection.
From the main Status screen, press the knob to move into the menu screen
(Figure 3.2, page 143). To move backwards in the menu tree, select the top
most menu selection on the current screen. Selections that will move you
backwards through the menu tree are noted by an upwards-facing arrow.
Note that if the menu is left idle it will automatically move back to the
main Status screen.

Figure 3.2: Main Menu

Preparing for a Print

Before starting a print you will need to set the hot end and heat bed to the
appropriate temperatures for the filament type you are using. To quickly
set the printer to preheat, click the selection knob to bring up the menu
and select Temperature. Select Filament Type to automatically set the
hot end and bed temperature for that specific filament.

If you need to set the extrusion and/or bed temperature to a setting
different than the preheat temperature you can manually set the temper-
ature. To do so, from the main menu navigate through: Temperature ->
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Custom Temp -> Nozzle or Bed. Clicking on either of these settings will
give you a menu to set and select the desired temperature setting.

Selecting a File From the SD and Starting a Print

Once the hot end and heat bed have reached the desired temperature the
printer is ready to print. From the main menu select the Print from SD
option. You will now see a selection of the directories and .gcode files on
the SD card. Navigate through the menu to locate the file you would like
to print. Select the desired file to begin the print.

Making Manual Movements With the Graphic LCD

As noted previously (page 140), making numerous manual movements
is easier done using Cura/Printrun. However, you can make manual
movements with the GLCD. Navigate to Movement -> Move Axis. You
will select the length of the movement and then which axis to move. Note;
that only 1-mm and 0.1-mm movements are allowed for the Z axis and
extruder.

When at the move screen; turn the selection knob clockwise to move
the axis in millimeters in the positive direction and counter-clockwise for
the negative direction.

Configuration Settings

Out of the box, the TAZ 3D printer is already calibrated for printing.
However, the GLCD does allow tuning of the more advanced configuration
settings. We highly suggest you not modify the configuration settings unless
you are certain it is necessary. These settings control how your printer
operates.

The Store Memory and Load Memory functions will store and load the
changes you make using the GLCD Controller. You must use the Store
Memory function to save the adjusted settings when the printer is powered
on. If you ever need to revert to the original factory settings navigate to
Control -> Restore Failsafe. Clicking Restore Failsafe will set all
configuration settings back to the original factory settings in the firmware.

For more information on the configuration settings please see the TAZ
support page on LulzBot.com.

144



Maintaining Your 3D Printer




Maintaining Your 3D Printer

4.1 Overview

Little maintenance is required keep your TAZ 3D printer running. Depend-
ing on your rate of use you will want to perform a quick check of your
printer every 2 to 4 weeks. The following maintenance guide lines will keep
your printer printing quality parts.

4.2 Smooth Rods

Wipe the smooth steel rods with a clean rag or paper towel. The linear
bushings leave a solid lubricant that builds up over time. Hearing squeaking
noises while the printer is printing is likely a sign that the smooth rods need
to be cleaned. NOTE: Never apply any lubricant or cleaning agent to the
smooth rods; the bushings are self-lubricating.

4.3 Lead Screw Drive Rods

Periodically, you will want to wipe down the threaded rods with a lithium-
based grease. Never use any petroleum based grease, which may com-
promise the plastic parts. We utilize Lucas white lithium grease NLGI #2.
Apply the lithium grease both above and below the X ends on the threaded
rods and wipe down the threaded rods. Use your preferred printer host
software or the Graphical LCD controller to drive the Z axis up and down
to help further distribute the lubricant.

4.4 PEI Surface

After repeated use, the PEI print surface will begin to need cleaning. To
clean the PEI print surface, Wipe clean with Isopropyl Alcohol and a clean
cloth. If you encounter prints lifting from the PEI surface, use a fine grit
sandpaper, typically 2000-2500 grit to clean the PEI print surface. We do
not recommend printing on bare glass, as it can lead to glass bed damage
or failure.
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4.5 Hobbed Bolt

The plastic filament is pulled through the extruder by a hobbed bolt. After
repeated use, the teeth of the hobbed bolt can become filled with plastic.
Using the brush or pick from the printer kit, clean out the hobbed bolt
teeth. If an extruder jam ever occurs, remove the plastic filament from the
extruder and clean out the hobbed bolt.

4.6 Belts

Over long periods or after extensive relocating of the printer you may need
to re-tighten the belts on the TAZ 3D printer. For the X axis, using the
2.5bmm hex driver, loosen one of the belt clamps. The belts clamps are
located on the X axis carriage. To loosen the belt clamp, loosen the M3
screws on the clamp. Using the needle nose pliers, pull the belt tight. While
holding the belt tight, tighten down the M3 screw. The Y axis belt can be
tightened using the same steps as the X axis using the belt clamps found
on the bottom of the Y axis plate. Make sure not to over tighten the belts
as this can cause unneeded stress on the printer.

4.7 Hot End

The hot end should be kept clean of extruded plastic by removing melted
plastic strands with tweezers. If melted plastic builds up on the hot end
nozzle you can clean it with a paper towel moistened with acetone or IPA.
Make sure the hot end is completely cool before attempting to wipe clean
the nozzle with acetone.

4.8 FElectronics

The electronics case holding the RAMBo board may need dust blown out
occasionally. Power down the printer and use the provided 2.5-mm driver
to remove the four M3 screws holding the lid to the enclosure. The fan
is mounted to the lid and connected to the RAMBo board. Be careful
with the fan cable during removal. Once it is removed use short bursts of
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compressed air to blow out any dust or debris. Plug in the lid fan, paying
attention to polarity, and reattach the lid.
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Advanced Usage

5.1 Intro

After you become familiar with printing using the default settings, a
few advanced techniques may help in getting better and more consistent
prints from the TAZ 3D printer. Some of these instructions are items
and materials not included with the TAZ. With any of these additional
items or materials, follow safety and usage guidelines as instructed by the
manufacturer.

5.2 Changing nozzles

The TAZ 3D printer is available with a tool head equipped with either
a 0.50mm or 0.35mm nozzle. The tool head with the 0.50mm nozzle
diameter will print faster than the 0.35mm nozzle tool head. Due to the
specific torque- 30 ft/Ib- required to tighten the nozzle when removed we
do not recommend removing the nozzle from the LulzBot Hexagon Hot
End. Failure to properly tighten the nozzle to the specific recommended
torque may lead to leaks or damage if over-tightened. Nozzle related issues
may not be covered under warranty after nozzle changes. We recommend
having the other nozzle diameter tool head /hot end on hand for quick, easy,
and simple changes.

5.3 ABS/Acetone Glue

Acetone is not included or required with the TAZ 3D printer. Acetone
and ABS solution is NOT recommended anymore, as the PEI print surface
works well without it.

You may find that during printing, printed parts lift off the print surface
on the corners. If you are seeing this turning on Brim in Cura or Slic3r
will help increase the surface area of the print, improving part adhesion. If
the corners of the part still lift, clean the PEI surface with IPA/ Isopropyl
Alcohol and sand the surface with fine grit (2000-3000) sandpaper.
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5.4 Using 1.75mm filament

Your TAZ 3D printer is set up to use 3mm plastic filament by de-
fault and may be capable of printing 1.75mm filament- your results
may vary. More information can be found in our User Forums at:
https://forum.lulzbot.com/viewtopic.php?f=16&t=1923
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Hardware and Software Source Code

The LulzBot™ TAZ 3D printer is a free/libre hardware design. All of the

source files are available at http://download.lulzbot.com/TAZ including:

The latest version of this document, with IXTEX source code.

3D models and print files for all of the printed parts in .stl, .gcode,
and other original source files.

3D calibration objects and random novelties.
Production file for calculating large print runs.
Design files for all electronics and machined parts.

— LulzBot Hexagon hot end
— RAMBo electronics
— Various spec sheets

Bill of materials including every part needed to build the printer.
— TAZ
— LulzBot Hexagon

Drawings of components.

— Aluminum extrusions
— LulzBot Hexagon
— Bed plate

Software binaries and source code for GNU/Linux and others. Also
includes known good configuration files.

— Cura

— Slic3r

— Printrun

— Marlin
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3D Printer Support

7.1 LulzBot

For common technical support questions for your TAZ 3D printer please
visit lulzbot.com/support. Also, visit forum.lulzbot.com for sup-
port and tips from the LulzBot community. If you have further ques-
tions, e-mail our support team at support@lulzbot.com. Please com-
pletely read this manual before contacting for support questions or
help. The latest version of this information guide is also available at
http://download.lulzbot.com. You can also find more information
including images, videos, and updated versions of this manual in the
Support section of LulzBot.com.

7.2 Community

Community Support and Resources

e LulzBot forum: forum.lulzbot.com
e IRC chat rooms on the irc.freenode.net server.

— #reprap: Highly active community chat room where help can
easily be found

— #slic3r: Slic3r chat room where Slic3r developers and users can
give help

o RepRap.org forums: forums.reprap.org
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Contact Information

8.1 Support

Email: support@LulzBot.com
Phone: +1-970-377-1111 x610

8.2 Sales

Email: sales@LulzBot.com
Phone: +1-970-377-1111 x600

8.3 Websites

Aleph Objects, Inc., the makers of LulzBot 3D Printers:
www.AlephObjects.com

LulzBot 3D Printers and parts:

www.LulzBot.com

forum.LulzBot.com
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Inner Shell Speed, 35 O
Installation, 15 OBJ, 7?
Interface Line Width, 42 OctoPrint, 56
Interface Thickness, 42 ooze, 95
IRC, 136, 156 Open Faces, 43
Isopropyl Alcohol, 146 OpenSCAD, 55
operating system, 15
L Orientation, 18
latex, 154 Outer Shell Speed, 35
Layer Height, 28 Overhang, 21
layer height, 110 Overhang Angle, 40
Layers, 23
lead screw, 146 P
license, 59 Paths, 129
Line Count, 39 Pause, 26 )
Line Spacing, 42 Pause at Z Height, 36
Load Model, 18 PEI surface, 146
lubricant, 146 Plater, 73, 106
plater, 47
M Plugins, 35
maintenance, 146 port, 51
Marlin, 154 post processing, 125
Material Selection, 17 power supply, x
MatterControl, 56 Print Settings, 77
Medium Quality, 17 Brim, 82
Menu Brim width, 82
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Infill, 80
Fill angle, 94
Fill density, 80, 90
Fill pattern, 80, 90
Fill Top/bottom fill pattern,
90
Infill before perimeters, 94
Infill every n layers, 94
Only infill where needed, 94
Only retract when crossing
perimeters, 94, 96
Solid infill every n layers, 94
Solid infill threshold area,
94
Layer height, 78
Multiple Extruders, 106
Output options
Post-processing scripts, 125
Perimeters, 79
Sequential printing
Extruder clearance, 118
Skirt and brim
Skirt, 97
Solid layers, 79
Speed, 81, 87
Acceleration control, 88
Bridges, 87
External perimeters, 87
First layer speed, 87
Gap fill, 87
Infill, 81, 87
Perimeters, 81, 87
Small perimeters, 87
Solid infill, 87
Support material, 87
Top solid , 87
Travel, 81, 87
Support material, 81

INDEX

Enforce support, 102

Generate support material,
81, 102

Overhang threshold, 102

Pattern, 102

Pattern Angle, 104

Pattern Spacing, 104

Pattern spacing, 81

Raft layers, 81

Print Speed, 30
printed parts, 154
Printer Host, 14
Printer Settings, 83

Custom G-code

End G-code, 85

Start G-code, 85

Tool change G-code, 107
Extruder

Extruder offset, 106

Nozzle diameter, 65, 85
Firmware

G-code flavour, 63, 85
Size and coordinates, 84

Bed size, 64, 84

Print center, 84

Z offset, 84

Printing, 77

printing, 25

Printing from SD, 24
Printing from USB, 25
Printing Temperature, 30
Printrun, 47, 50, 51, 154
profiles, 115

create, 115
delete, 116

pronsole, 47

pronterface, 47
PTFE tube, 151
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Q
Quick Print Profile, 17

Quick Print Settings, 16

R
Raft, 32, 42
RAMBo, 147, 154
Removing a Print, 26
RepRap, 136, 156
Resolution, 17
Retraction, 29, 38
retraction, 95
Retraction Distance, 33
Retraction Speed, 32

S
Sane Defaults, 130
scripting, 120
scripts, 125
SD card, 47
Second Extruder Offset, 46
Sequential Printing, 118
Setting Dual Temps, 47
Shapesmith, 55
Shell Thickness, 29
simple mode, 77
Skirt, 38
skirt, 97
Slic3r, 154
Slicers, 14
Slicing, 14
smooth rods, 146
software, 14, 54, 56, 154
Source Code, 59, 154
speed, 86
Spiralize, 41
Start Distance, 39
static, xi
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STL, 18, 54, 56, 72, 154
cleaning, 76

stl, 47

Support, 40, 41

Support Material, 17, 40

support material, 101

Support Settings, 40

Support Type, 30

Surface Layers, 43

T
technical support, 156
temperature, x, 47, 98
Temperatures, 26
threaded extension, 150
threaded rods, 146
Top Thickness, 29
Travel Speed, 34
Tweak at Z, 36

U
Updating Firmware, 44
USB cable, 51

\Y%
View Options, 20

W
warnings, x
warping, 150
website, 136
Windows, 15, 49, 55, 56
wires, x
wrench, 150

X
Xray, 22

Z
7 hop, 38
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Z Wobble, 134
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.gcode The file extension for G-Code files

3D Printer Also referred to as additive manufacturing, is the process
of fabricating objects from 3D model data, through the deposition of a
material in accumulative layers.

ABS Acrylonitrile butadiene styrene thermoplastic. Usually extrudes at
230C.

Acetone A colorless, volatile, flammable liquid ketone, (CH3)2CO, used as
a solvent for ABS.

Baud Rate Refers to the speed at which the host controller communicates
with the 3d Printer electronics.

CAD Computer Aided Design
Cura Cura is a cross-platform software package that combines a slicing
engine with a printer host interface.

Filament Plastic material in a string like form, as it is fed to the printer.
free/libre Free/Libre hardware and software can be thought of as free as in
free speech, not just free as in free beer, although most free/libre software
is available for no cost. Libre hardware designs can be copied, modified
and are usually available for download. Free/Libre software can be used in
a similar fashion.

GCODE The common name for the most widely used CNC programming
language.

HDPE High-density polyethylene.
Heater block Machined from aluminum, the heater block generates heat
with a heater resistor and uses a thermistor to measure the temperature.
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Heater resistor A special type of resistor that is used to apply heat in a
small area.

HIPS High-impact polystyrene.

Hot end The hot end is the whole part where the plastic melts, including
the nozzle, heater block, thermistor, and heat sink. The LulzBot™ Hexagon
all-metal hot end comes standard on the TAZ 5.

Layer height The thickness of each individual deposited layer of the three-
dimensional model when cut with a slicing program.

Laywoo-D3 Wooden filament similar to PLA. Forty percent of its content
consists of recycled wood. Usually prints at 180C to 210C. Color can be
changed by varying the extrusion temperature.

Nozzle The metal tip at the bottom of the hot end. It has a small hole
where the plastic filament comes out of the printer.

PLA Polylactic acid is a corn-based biodegradable polymer. Usually
extrudes at 185C.

Polycarbonate A strong and impact-resistant thermoplastic. Usually ex-
trudes at 300C.

PTFE Polytetrafluoroethylene is a synthetic fluoropolymer used in the
Budaschnozzle for it’s low coefficient of friction. The TAZ 5 does not use
a hot end with a PTFE insert.

RAMBo [R]epRap [A)]duino-[Mlega compatible [M]other [Bolard. De-
signed by Joynnyr of Ultimachine.

Resolution In general terms, the resolution you print at can be determined
by the layer height you print at. The LulzBot TAZ can print at a layer
height of 0.05mm to 0.35mm.

Slic3r Slicdr is a cross-platform 3D model slicing engine. It’s used to process
the 3 dimensional model into the gcode (toolpath) needed to physically
generate the print.

Spool Plastic filament coiled and stored on a plastic reel. Preferred over
1.75-mm filament due to improved feeding and better mounting options.

Thermistor A special type of resistor that changes resistance based on
temperature. It is used to measure temperature on the nozzle and the

heated bed.
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Threaded extension Used to separate the heater block and nozzle from
the PEEK insulator. The plastic filament passes through the threaded
extension into the melting chamber.
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